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1.1 Introduction to this manual
This manual covers the operation of the Mastersizer particle characterization systems. These
instruments measure the size of particles contained within a sample, presenting data accord-
ing to your needs.

Manuals available are:

l Mastersizer Basic Guide
l Mastersizer User Guide
l Additional manuals for the Hydro Series Wet Dispersion Units and Aero Series Dry Dis-

persion Units.

Electronic versions of all the manuals can be downloaded from the Support & downloads sec-
tion of the Malvern Panalytical website and are also available in the Help system.

WARNING - General hazard
The instrument and the samples to be measured may be hazardous if misused. Users
must read the Health and Safety information in the Mastersizer Basic Guide before
operating the system.

1.1.1 About this manual
The operation and maintenance of the following units are covered:

Table 1.1 Mastersizer units

Item Description Model numbers

Mastersizer 3000 Mastersizer 3000 optical unit MAZ3000

Mastersizer 3000E Mastersizer 3000 entry level optical unit MAZ3010

Mastersizer 3000+ Lab Mastersizer 3000+ optical unit MAP3020

Mastersizer 3000+ Pro Mastersizer 3000+ optical unit MAP3010

Chapter 1 Introduction
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Item Description Model numbers

Mastersizer 3000+
Ultra

Mastersizer 3000+ optical unit with blue detector MAP3000

Hydro SV Small volume (SV) automatic wet dispersion unit MAP3100

Hydro SM Small volume (SM) manual wet dispersion unit MAZ3150

Hydro MV Medium volume (MV) automatic wet dispersion unit MAP3210

Hydro LV Large volume (LV) automatic wet dispersion unit MAP3310

Hydro EV Extended volume (EV) user-interactive wet dispersion
unit

MAP3400

Aero S Automatic dry dispersion unit - options include stainless
steel and ceramic venturi dispersers

MAP3500

Aero M Manual dry dispersion unit - options include stainless
steel and ceramic venturi dispersers

MAP3550

1.2 Assumed information
To use this manual, you must understand the product naming convention and how menu com-
mands are described.

1.2.1 Mastersizer versions and software
There are three core instruments in the Mastersizer range: the Mastersizer 3000E, Mastersizer
3000 and Mastersizer 3000+. The differences between these instruments are explained in the
Mastersizer Basic Guide.

The Mastersizer 3000E, 3000 and 3000+ are referred to as the Mastersizer (or “the optical
unit” or “the instrument”), unless specifically named to highlight any differences.

The combination of the instrument, connected accessories and the computer is referred to as
“the system”.

Chapter 1 Introduction
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The software used to operate the Mastersizer instruments is referred to as Mastersizer
Xplorer.

1.2.2 Menu commands
Menu commands in the software are always shown in bold text in the form:

main menu > item

As an example, the command File > Options refers to selecting Options from the File menu.

1.2.3 Keyboard interaction
Keyboard interactions are shown in a shaded box. For example:

Press the Ctrl key.

1.3 Where to get help
This section gives information on the various channels in place to get help with your Master-
sizer system.

1.3.1 Website - www.malvernpanalytical.com
Our website offers a comprehensive range of resources for use by customers. It gives free
access to exclusive content including webinars, presentations, application notes, technical
notes, whitepapers, software downloads and more.

1.3.2 Help system
A full help system is supplied with your Malvern Panalytical software system. This provides
detailed reference information on all software features. To access this, press F1 or click the
Help button within the application (sometimes indicated by a question mark icon).

1.3.3 Technical support
All queries about the system must be directed to your local Malvern Panalytical representative,
quoting the following information:

Chapter 1 Introduction
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l Model and serial number of the instrument (usually located on the outside casing of the
instrument).

l Software version (see File > About in the software).
l Firmware version (Technical support will inform you how to locate this information).

Visit www.malvernpanalytical.com to find your local Technical Support representative.

Chapter 1 Introduction
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2.1 Software compatibility
The following software features are available with the basic software for all instruments:

l SOP operation.
l Customized reporting.
l Entry level legacy system result compatibility tools.
l Software bug fixes.

In addition, IQ/OQ validation is available for the Mastersizer 3000+ Ultra, Mastersizer 3000+
Pro and Mastersizer 3000 instruments.

2.1.1 Extended software
The following Extended software features are available for all instruments except the Master-
sizer 3000+Lab and Mastersizer 3000E Basic:

l Advanced method development and comparison tools.
l Advanced data quality assessment and reporting tools.
l Advanced measurement manager functions.
l Measurement sequencing / SOP player tool.
l User workspace functions.
l New feature additions and upgrades.
l Ability to use the software on multiple workstations.

Note: The extended software must be purchased separately. Contact your Malvern
Panalytical representative for more information.

Throughout the Mastersizer User Guide and Help system, extended software features are
marked like this: EXTENDED FEATURE

2.1.2 Software packages and feature keys
In addition, certain software features are controlled by feature keys (licenses) that can be pur-
chased individually, or are supplied as part of a software package.

Chapter 2 Software overview
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The various packages and features are shown in the following table.

Table 2.1 Software feature keys

3000+ Ultra 3000+ Pro 3000

Software package: Workflow Expert
(included with instru-
ment)

Workflow Developer
(included with instru-
ment)

Workflow Guidance
(optional purchase)

Data Quality Guidance • • •

SOP Architect • •

Size Sure meas-
urement mode

•

Optional purchase

CFR 21 part 11 via
OmniTrust

• • •

Throughout this guide and Help system, features that require an extra feature key (license) are
marked like this: FEATURE KEY

2.1.3 Alternative Mastersizer analyses
If you have upgraded an instrument and want to compare old and new data sets, you can ana-
lyze results as if they were made on a previous instrument.

l Measurements on a Mastersizer 3000+ Ultra can be analyzed as if they were made on a
3000+ Pro or 3000+ Lab.

l Measurements on a Mastersizer 3000+ Pro can be analyzed as if they were made on a
3000+ Lab.

l Measurements on a Mastersizer 3000 can be analyzed as if they were made on a 3000E.

Refer to section 10.5.1.3 for details on how to apply these settings in the SOP Editor.

Chapter 2 Software overview
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2.2 Main window
The main software window, with a measurement file loaded, is shown as follows:

Chapter 2 Software overview
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1. Ribbon selector tabs – Gives quick access to the different control ribbons. The Application button
(leftmost) gives quick access to file, print and software options as well as software version inform-
ation.

2. EXTENDED FEATURE Private/Shared workspace – The workspace shows the settings and data
assigned to the user or users using the instrument at the time. Individual (private) or common
(shared) workspaces can be created.

3. Record View panel – Lists all measurements in the active measurement file. Multiple measurement
files can be opened simultaneously, which are then accessible by different tabs.

4. All files tab – View all records from all open measurement files in a single tab.

5. Control ribbon – Single-click access to key software functions.

6. Reports tabs – Reports on the currently selected record. The reports shown are a function of the cur-
rently selected workspace.

7. EXTENDED FEATURE Data Quality tab – Gives guidance on measurement quality and displays pass/fail
data report based on selected models, plus tips on how to improve the measurement.

8. Status bar – Shows the instrument mode, 21 CFR status, notifications, connected accessory type
and connection status (as well as its serial number when connected).

Figure 2.1 The main software window

2.2.1 Control ribbons
Control ribbons give quick access to key software functions.

To select an option, click on the direct-access button, for example Extract SOP.

Figure 2.2 The Home control ribbon

The following control ribbons are available:

l Home - used to create, edit and run measurements and SOPs.
l View - used to change the window layout and column configurations.

Chapter 2 Software overview
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l Tools - links to materials and dispersants databases and other tools.
l Review - used in a regulated environment.
l Help - links to the software help system.

2.2.2 Record View tab
The Record view allows you to view and edit the records contained in Mastersizer meas-
urement files. You can also open files that were created by Mastersizer 2000 instruments, but
not edit them. Mastersizer measurement files have several individual measurement records.

Figure 2.3 The Record view

Each open measurement file has a tab in the Record view - click one of these tabs to show all
the records contained in that measurement file.

Each measurement has a set of parameters, one of which is shown in each column of the
Record view.

Full details of the Record View options are described in Chapter 6.

2.2.2.1 Reports tab

In the Reports tab, reports are displayed automatically whenever you select a record, or num-
ber of records, from the Record view.

Chapter 2 Software overview
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Figure 2.4 Reports tab

For detailed information on the process of viewing, editing or creating new reports, refer to
Chapter 7.

Chapter 2 Software overview
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2.3 Data Quality tab - EXTENDED FEATURE
The Data Quality tab presents a custom analysis of any records selected in the current meas-
urement.

1. Select the records for which you wish to view a data quality report.

2. Click the Data Quality tab.

Figure 2.5 Data Quality tab

3. Click the Data Quality Guidance tab to view the overall data quality.

Items that have good data quality are shown:

Figure 2.6 Good data quality

Items that have poor data quality are shown:

Figure 2.7 Poor data quality

Note: When the Auto-refresh button is green the display automatically refreshes the data
quality view whenever a new record is selected. Click the button to toggle this func-
tionality.

Click the fail/pass buttons to toggle whether items that have passed or failed
are displayed.

Chapter 2 Software overview
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Results can be shown in a tabular or list format.

2.3.1 Data Quality Guidance - FEATURE KEY
The information displayed is more detailed if you have a DQG license.

l The guidance gives an indication of quality for both the background measurement
and the sample:

Figure 2.8 Good data quality with DQG license

Chapter 2 Software overview
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l If the data quality is poor, the guidance gives more information indicating the
reason for the poor quality and suggestions for how to improve it:

Figure 2.9 Poor data quality with DQG license

The data quality information is also analyzed and can be viewed while a measurement
is running. Refer to section 5.2.7 for further details.

Chapter 2 Software overview
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2.3.2 ISO, USP and Manual %RSD checks
The three other tabs show further data quality guidance. For each of these, the icon indicates
the quality of the data.

Table 2.2 Data quality icons

Icon Description

Insufficient records have been selected to provide accurate guidance.

Fail - the records have failed the check.

Warning - the records have passed the check but fewer than the recommended records
have been selected.

Pass - the records have passed the check.

Chapter 2 Software overview
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2.3.2.1 ISO Check

This checks the stability of results against the recommendations of the ISO 13320 standard.

Click the ISO Check tab to view the ISO variability for the selected records:

Figure 2.10 ISO Check tab

Note: ISO recommends a minimum of 5 repeat measurements.

Chapter 2 Software overview
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2.3.2.2 USP Check

This checks the stability of results against the recommendations of the USP 429 standard.

Click the USP Check tab to view the USP variability for the selected records:

Figure 2.11 USP Check tab

Note: USP recommends a minimum of 6 repeat measurements.

2.3.2.3 Manual %RSD

The manual RSD check lets you enter custom Dv values and limits.

1. Click the Manual %RSD tab.

2. Enter the low, mid and upper Dv value.

3. Enter the limit for each of the Dv values.

4. Click Apply.

Chapter 2 Software overview
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Figure 2.12 Manual %RSD tab

2.4 Malvern Panalytical Portal
Click the Malvern tab to open the Malvern Panalytical portal.

The Malvern Panalytical portal provides the facility to set up and view RSS (Really Simple Syn-
dication) feeds, predominantly for content, posts and articles published by Malvern
Panalytical. This can include software updates, technical and applications notes, etc.

Additionally, the portal can be configured to include RSS feeds from other requested websites.

2.4.1 Configure the feeds
The default view includes all Malvern Panalytical feeds for the Mastersizer. The view can be
configured to filter for particular interests or particle types.

Chapter 2 Software overview
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1. From the portal menu click Configure feeds...

Figure 2.13 Portal menu

2. Select the Malvern Panalytical products that you want to see in the feed:

Figure 2.14 Malvern Panalytical product feeds

Chapter 2 Software overview
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3. To add third party feeds, enter the Url for the feed or click the Suggestions button to see
a list of suggested feeds:

Figure 2.15 Add new feed

2.4.2 View feeds
Click in the portal header to view all the feeds that are available.

Select each one to change the main view.

Figure 2.16 Feeds available to view

Chapter 2 Software overview
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2.5 Status bar indicators
The status bar provides several indicators that show information about the instrument and its
status.

Figure 2.17 Status bar indicators

l 21 CFR - indicates whether security is enabled on the system. Refer to Chapter 8 for
more information.

l Maintenance - the Status bar provides a visual reminder that maintenance tasks are due
to be completed.

l Notifications - the Status bar provides a visual reminder that notifications are available.
Notifications are brief notes that indicate any errors, problems or necessary remedi-
al/investigative action that may be required to keep the system functioning correctly. Fol-
low the advice given in any notifications and then click Clear All to remove them.

2.5.1 Instrument connection status
The instrument and accessory connection status icons show the serial number of the instru-
ment, the name of the connected accessory and to which (CAN) port it is connected.

Table 2.3 Instrument connection status

Icon Meaning Action

Correct con-
nection to the
instrument

None

Instrument not
connected cor-
rectly

Check the instru-
ment’s con-
nection to the
USB port on the
PC and the
power con-
nections to the
instrument.
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Icon Meaning Action

Dispersion unit
not detected

Check con-
nection from
instrument to dis-
persion unit.
Blue pulsating
power light on
dispersion unit
indicates correct
connection.

2.6 Workspaces - EXTENDED FEATURE
Workspaces are a collection of settings that define the information presented in the Reports
and Record view. They also define which folders the system uses for accessing SOPs, meas-
urement data and export data.

Each user can access a Private and a Shared workspace, both of which are configurable. This
makes it easy for an individual to optimize the software for their own use with the private work-
space, or to collaborate better across an organization using a shared workspace - this is par-
ticularly useful within regulated environments. The shared workspace can be set as the only
view - this is done using the Options window.

The following settings and data are associated with the workspace:

l SOPs and SOP Templates presented to users
l Record parameters shown in the Record view
l Reports listed in the Reports view
l Measurement data file location
l Exported data and Export Templates file locations
l Workspaces also control where the software will look for data quality add-ins, macros,

user calculations, etc.

Chapter 2 Software overview
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Note: Any of these items that are created when the Shared workspace is active will be avail-
able to all users of that system (providing their security privileges allow them access to
these functions). If the Private workspace is selected, these items are only available to
the current user.

2.6.1 Selecting the workspace

l To show the Workspace panel click at the top of the Workspace panel. Click the
button again to close the Workspace panel.

l To select the required workspace click at the top of the Workspace panel:

Figure 2.18 The workspace panel

Any work subsequently performed on the system will now use the selected workspace both to
save data and to access settings.

2.6.2 Recent measurement files
This is a simple list of the last five measurement files that have been accessed within the selec-
ted workspace.

Chapter 2 Software overview
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Figure 2.19 Recent measurement files list

Pin measurement files and SOPs within the workspace to keep them in the list indefinitely. To
do this, hover the mouse over the item and select the pin button.

2.6.3 Record and reports view selector
The record parameters shown in the Record view, and the reports listed in the Reports view
are controlled using the record and reports view selector to the right of the of the workspace
panel. Additionally, the records and report selector stores (and restores) any selected data
quality add-ins.

Figure 2.20 Record and report view selector

You can add as many different views as required. These are stored within the currently selec-
ted workspace.

Chapter 2 Software overview
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2.6.3.1 Add a new view

1. Click Add new view from the Workspace panel.

2. Enter a name in the Result View Properties window.

3. Click Configure record view columns to show the Parameter Selection window (refer
to section 6.3). Select the required parameters and then click OK.

4. Similarly click Configure report selection to display the Report selection window (refer to
section 7.5), select the required reports and tab order, and then click OK.

5. Click on a view in the list to make it the active view. The selected view is shown in the
record and reports view selector title.

The Reports and the Record view are updated immediately.

To edit or remove a view, select it from the list and click the Edit or Remove
icon .

2.6.4 Targets
Targets are links to Mastersizer system folders, providing quick access to all of your meas-
urement data, reports, SOPs and more. Click a target to open the respective folder within Win-
dows Explorer. The targets shown are specific to the selected workspace.

If the Private workspace is selected, the folders all stem from:

C:\Users\YOURNAME\Documents\Malvern Instruments\Mastersizer 3000\Workspace\

If the Shared workspace is selected the folders stem from:

C:\ProgramData\Malvern Instruments\Mastersizer 3000\Workspace\

2.6.5 Shortcuts
Shortcuts allow you to set up links to folders, e.g. on a network, that can be shared between all
users on that PC.

l To create a shortcut, drag a file/folder/website into the Shortcuts panel in Windows
Explorer.
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2.7 Show Current Results
As the number of records in a measurement file increases it can become difficult to view. To
overcome this, a Show Current Results option is available. This restricts the records list so that
only the most recent result of any record is shown.

Figure 2.21 Show current results option

Figure 2.22 Enabled - current records only shown (no edited records)

Figure 2.23 Disabled - all records are shown (includes edited records)

Chapter 2 Software overview
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2.8 Save/Restore layout - EXTENDED FEATURE
Save layout lets you store the exact position of all elements of the Mastersizer Xplorer inter-
face. This could be useful in situations where you have optimized the interface for your current
analysis process.

Figure 2.24 Save layout option

2.8.1 Position elements within the User interface
To reposition items:

1. Drag any of the following panels to an alternative location within the main window:
Record View, Data Quality, Reports and Workspace Viewer.

2. Release the mouse button to place the element.

2.8.2 Save or restore the window layout
To save commonly used panel and window arrangements for future use:

l Position any of the panels of the software as desired, for example, the Workspace
Viewer, Record View etc.

l Click Save My Layout on the View ribbon.
l The New Layout File window is displayed. Enter a name for the layout (all layouts have

the .mlay file extension) and click Save.
l To access a previously saved layout, click Restore My Layout and then locate the rel-

evant .mlay file.
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Note: By default, the system always returns to the window layout that was present when the
software was last closed. Layouts are not saved once the software has been closed
unless you use the method above.

2.9 Predefined window layouts
The predefined window layouts allow to you quickly select from several optimized panel
arrangements within the Mastersizer user interface.

l From the Predefined window layouts group in the View ribbon, select the required layout.

Figure 2.25 Predefined window layouts

2.10 Options
The Options window provides additional control over software presentation and security. If
options are not selected they will not be available for use.

1. Click File > Options to display the Mastersizer Xplorer - Options window.
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Figure 2.26 Mastersizer Xplorer Options window

2. Click the links on the left to view the corresponding settings. This is split into the fol-
lowing sections:

l General
l Theme
l Graphs
l Folders
l Extended software features
l 21 CFR part 11

Chapter 2 Software overview
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2.10.1 General
Table 2.4 General settings

Setting Description

Show settings when running
manual measurements

With this option selected, the measurement settings window is auto-
matically displayed upon initiation of a manual measurement. This is
useful in method development as alterations to measurement settings
in the records view can be made.

Force saving of records With this option selected every measurement file will be saved on cre-
ation with temporary measurement files no longer being made. The
measurement files will automatically be saved when the software is
closed, so there will be no prompting for changes to be made.

Note: This option is automatically enabled and cannot be changed
when the 21 CFR feature is installed.

Shared workspace only Select this option to only use the Shared workspace. This will be the
default setting when the software is opened and any Private work-
spaces will not be available to either view or setup. Deselect this option
to allow private workspaces to be set up and viewed.

Enable Mastersizer
2000/2000E Analysis Emu-
lator

Enable this option to add 3 additional emulated Mastersizer
2000/2000E analysis models to the list of analysis models in the Data
processing – Analysis SOP and record editor.

The emulator converts Mastersizer 3000, Mastersizer 3000E and
Mastersizer 3000+ results into how they would be analyzed on a
Mastersier 2000 instrument. Refer to section 10.5.1.

Enable virtual lens ranges This enables the controls on the advanced analysis page of the SOP
for virtual lens ranges. Virtual lens ranges limit the result analysis range
to that of a legacy instrument, such as a 300 mm lens used on a Master-
sizer X.

Display results to 3 decimal
place precision

This option enables the software to display results to 3 decimal places.
This is the same precision as used in the Mastersizer 2000 software.

Chapter 2 Software overview
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2.10.2 Themes
Several themes are available which modify the color settings of the user interface. Click
Theme from the Options window and then select a scheme that suits your preference by click-
ing Use this theme.

Figure 2.27 Available themes

2.10.3 Graphs
Choose Graphs from the Options menu to access further options that relate to the present-
ation of graphs:

Chapter 2 Software overview
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Figure 2.28 Graphing options

2.10.3.1 Line weight

Specify the line weights (Normal, Light or Heavy) to be used in all graphs.

2.10.3.2 Color scheme

Choose from one of several color schemes.

The Mastersizer 2000 theme emulates the appearance of the Mastersizer 2000 graph color
scheme. Grayscale is optimized for printing on a monochrome printer. High Contrast provides
better on-screen visibility.

2.10.3.3 Legend parameters

By default the graph legends show the sample name (the Legend parameters box is empty). If
you want to change this to identify data based on other parameters, click the Configure button
and select which parameters you want to use.
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2.10.4 Folders
Use this option to either view, by clicking on the folder, or edit the folders where the Mal-
vern Panalytical data is stored.

Figure 2.29 The various Folders where Malvern data is stored

2.10.5 Extended software features
The same software controls all Mastersizer instruments. However, some software features are
not available for the Mastersizer 3000E Basic and Mastersizer 3000+ Lab, which provides only
the core functionality. The extended software features are only available with an Extended
software license.
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Figure 2.30 Extended software features

2.10.6 21 CFR Part 11 - FEATURE KEY
21 CFR Part 11 is an FDA compliance requirements specification for computer systems that cre-
ate, modify, maintain, archive or retrieve electronic records required by the FDA for inspection
or submission under a predicate rule. 21 CFR Part 11 compliant auditing for Mastersizer Xplorer
is provided through the OmniTrust software.

Note: Contact your local Malvern Panalytical representative for more details.

Full details of the OmniTrust features are provided in Chapter 3.

2.11 Maintenance
The Maintenance window gives background information about the system that can be useful
during maintenance or when contacting the Malvern Panalytical Technical Support.

Click Tools > Maintenance to display the Maintenance window:

Chapter 2 Software overview
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Figure 2.31 Maintenance window

The window is broken down into the following sections.

2.11.1 Notifications
Brief notes that indicate any errors, problems or necessary action that may be required in
order to keep the system functioning correctly. Follow the advice given in any notifications
and then click Clear All to remove them.

The Status bar also provides a visual reminder that notifications are available:

Figure 2.32 Status bar

Click the Notifications icon on the status bar to view the Maintenance window.

Chapter 2 Software overview
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2.11.2 System information
Details about the software, operating system and hardware connected. This information must
be passed to the Malvern Panalytical Technical Support whenever you log a support call. To
send this information to Malvern Panalytical:

If you have email software on the Mastersizer computer:

1. Click Contact Malvern to display the contact form.

2. Complete the form and then click OK. Your default email software then starts and an
email is generated containing the relevant system information.

3. Additional fields appear in the email where you can input information about the issue you
are experiencing with the Mastersizer system.

If you do not have email software on the Mastersizer computer:

1. Click Save text report to save a text file containing this information.

2. Copy this information onto a data stick and transfer it to a PC that has an email con-
nection in order to attach the file to send to Malvern Panalytical.

3. Print the information using the Print option and then refer to this information if you wish
to contact Technical Support via telephone.

2.11.3 Maintenance reminders
Maintenance reminders can be set up within the software to prompt users to carry out routine
maintenance tasks. To configure these:

1. Access the Tools > Maintenance window. Within the Maintenance window, there is a
Maintenance reminders section, where any active reminders are listed.

Figure 2.33 Maintenance reminders section
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2. Click on the Configure icon to open a list of active maintenance tasks, from which exist-
ing tasks can be edited, or new ones added:

Figure 2.34 Edit active maintenance tasks

3. Click on a maintenance task to show its full details. If the task requires editing, select the
Modify button.

To set up a new maintenance task:

1. Click the Add button. The details required include:

l Name - a task name.
l Notifications from - the date when users should start being prompted to

carry out a task.
l Task due by - the date by which the task needs to be completed.
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l Repeat interval - how often the task should be done (weekly, monthly,
yearly, etc).

l Task description - text that provides guidance as to what needs to be
done by the user.

l All users can complete task option - select this checkbox to confirm that
any user can complete the task. If this is left not checked then only users
who have the Open Maintenance security permission assigned to them
can set the task to done. This could, for instance, apply to tasks asso-
ciated with booking a service or OQ visit, where it would be the super-
visor's responsibility to complete the task.

2. Users are alerted to tasks which are due to be carried out by a Maintenance icon in the
status bar. Clicking on this will display the maintenance detail.

Figure 2.35 Maintenance information from the status bar

3. Click Done? to clear the task.

4. If the task is not completed by the due date then a service notification is generated and is
displayed on the application's status bar.

Figure 2.36 Service notification icon in status bar
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2.11.4 System health checks
The Mastersizer software constantly checks the status of the optical system and the dis-
persion units to make sure it is functioning correctly. If issues are detected, they are reported
within this section for the maintenance report.

Perform a health check at any time by selecting the button. The results of the
tests will be reported in the System health checks section of the Maintenance window.

Figure 2.37 System health checks

Note: Connection to a system is required for this option to work.

2.11.5 System usage
The total running time of the instrument and any connected accessory. Details are provided on
the running time of the accessory stirrer and ultrasound if applicable.

2.11.6 Logs
Links to the last six logs generated by the system. These files are not of direct benefit to users,
but may be requested by the Malvern Panalytical Technical Support when trying to resolve an
issue.

2.11.6.1 To send a log file:

1. Click on the Save Text Report option on the maintenance report icon bar. This will record
a new system status report.

2. Click on the Open folder option within the Logs section of the report. This will open the

Chapter 2 Software overview



42

directory that contains all of the system logs.

3. Copy all of the logs, and email these to Malvern Panalytical.

Note: If a software crash has occurred, a series of crash dump files (.dmp) will be stored in
the logs directory alongside any maintenance reports and a trace.log file. These files
contain detailed information about how any crashes occurred, and should therefore be
sent to Malvern Panalytical along with any maintenance logs.

2.11.6.2 Log view

The log view lists system events that occurred during the measurement, such as "5 saturated
snaps reported".

1. From the main Measurementdisplay window, click the Log view tab on the right.

2. The list of events in the log is presented in time-order

Figure 2.38 The Log view

3. A warning triangle icon next to an event indicates that the measurement or accessory
settings may require further adjustment to obtain a satisfactory measurement.
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2.12 Measurement display
The measurement display allows you to control the measurement sequence once started. The
same display is used to control both SOP and manual measurements. Additional tabbed panel
controls are available depending on the Mastersizer software installation.

Figure 2.39 Measurement display

Refer to section 5.2 for a description of the Measurement display and features.
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3.1 Introduction - FEATURE KEY
Note: This section is for OmniTrust users only. OmniTrust is Malvern Panalytical's solution for

organizations working in a regulated environment. Contact your local representative
for more information.

OmniTrust is a connected solution that allows you to configure and maintain a regulated envir-
onment within your organization. Designed in collaboration with leading industry experts,
OmniTrust provides a common approach to validation and data integrity across a range of
instruments. OmniTrust software tools provide a simple, user-friendly interface, speeding and
simplifying the process of carrying out critical data integrity audits.

Several features have been introduced to support Mastersizer's integration with the
OmniTrust solution. These are explained in detail within this section.

3.2 User authentication (log on)
When OmniTrust is configured to control your regulated environment, users may need to enter
their credentials when they start a regulated application, such as Mastersizer. Your system
can, however, still authenticate users without the need to log on - this can be configured in
OmniTrust.

After starting the software, the user authentication (log on) window may be shown:
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Figure 3.1 User Authentication window

If the User Authentication window is shown:

1. Enter the appropriate User Name and Password.

2. Click Sign in to access the application.

The credentials you need to enter will depend on how OmniAccess is configured. Typically,
this could be your normal network log in. Contact your system administrator for more inform-
ation.

3.3 User account menu
The initials of the currently logged in user are shown in the icon in the main Mastersizer win-
dow toolbar. Click on the icon to reveal more details about the user:

Figure 3.2 User account (OmniTrust user)
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The information shown is as follows:

l User login name - the login name of the user.
l User Name - the full name of the user.
l Role - the role assigned in OmniAccess to the user. This governs the user's permission to

perform various functions in the Mastersizer application.

3.4 Sign for an event
Depending on how your OmniTrust system is configured, you may need to sign for specific sys-
tem events, such as when a record is created or a measurement is aborted. Additionally you
may need to give a reason and enter a password for those events. However, OmniTrust can
also be configured so that signatures and reasons are not required. (Refer to the OmniAccess
Help system under Signing and Reason.)

The following example shows a user signing for an event after they have run a measurement:

Figure 3.3 Sign for Event
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3.5 Review menu
The other OmniTrust functions are accessed from the Review menu:

Figure 3.4 Review menu

The menu options are as follows:

l Records - to view the record audit trail. Refer to section 3.6.
l Approve - to approve a record. Refer to section 3.7.1.
l Reject - to reject a record. Refer to section 3.7.1.
l Lock - to lock a record. Refer to section 3.7.2.
l Unlock - to unlock a locked record. Refer to section 3.7.2.
l View Approvals Report - to view the approvals report for a record. Refer to section 3.8.

3.6 View the Record Audit Trail
Specific events in the history of a record are logged in its Record Audit Trail.

To view this information:

1. Select a record in the record view.

2. Click the Records button on the Review toolbar or select the option from the right-click
menu as shown:
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Figure 3.5 View the Record Audit Trail

The Record Audit Trail is shown:
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Figure 3.6 Record Audit Trail

All events relating to the record are shown. The items are clearly separated with their own
blocks of information pertinent to that event. The most recent event in the record's audit trail is
shown at the bottom of the list. In this example, the record was created on 10 May at 10:33 by
the Administrator. It was then approved at 12:00 and locked at 12:00.

3.6.1 Export the audit trail
To export the displayed record audit trail:

1. Click the Export button:
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Figure 3.7 Export Audit Trail

2. Select the export format. The audit trail can be saved as a PDF, XML or CSV format.

3. Select where you want to save the exported file.

The example below shows the previous audit trail exported as a PDF file:

Figure 3.8 Exported PDF
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3.7 Approve, Reject, Lock and Unlock results
These functions are usually performed by system supervisors or administrators. They allow
them to quickly approve or reject results and lock or unlock results. The following rules apply
to approving and locking records:

l A record can only be locked after it has been approved or rejected.
l The Signed By Final Reviewer field is only updated to "Yes" when a record has been

approved or rejected, and locked.
l Once a record is locked it's approve/reject status can only be changed by unlocking the

record again.
l Unlocking a record removes any previous approve/reject status.

The status of the records is indicated by different colored shading:

Figure 3.9 Record status indicated by colored shading

Table 3.1 Record status colors

Shading Color Status

None Record not approved or rejected, not locked

Green Record approved, not locked

Grey Record rejected, not locked

Orange Record approved or rejected, and locked
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3.7.1 Approve or Reject results
To record an approval or rejection in the Record Audit Trail:

1. Select a record in the record view.

2. Click the Approve Result or Reject Result button on the Review toolbar. You can also do
this by right clicking a record:

Figure 3.10 Approve or reject a result

Chapter 3 Regulated environment with OmniTrust



55

l Approve - Electronic Record Approved event logged in the Record Audit Trail.
l Reject - Electronic Record Rejected event logged in the Record Audit Trail.

3. You may need to sign and give a reason for approving or rejecting the record:

Figure 3.11 Sign for Electronic record approved

3.7.2 Lock or Unlock records
To lock a record:

1. Select a record in the record view.

2. Click the Lock button on the Review toolbar. You can also do this by right clicking a
record:
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Figure 3.12 Lock a record

3. You may need to sign and give a reason for locking the record:
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Figure 3.13 Sign for Electronic record locked

When a record is locked, the results can no longer be edited.

Note: If you need to unlock a locked record, repeat the previous steps and click the Unlock
button. If you unlock a record, it completely removes any previous approve/reject
status.

3.8 View the Approvals Report
The Approvals Report is a list of the approve/reject and lock/unlock events for a record. To
view the approvals report:

1. Select a record in the record view.

2. Click the View Approvals Report button on the Review toolbar or select the option from
the right-click menu as shown:
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Figure 3.14 View Approvals Report

The Approvals Report is shown:
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Figure 3.15 Approvals Report

All events relating to approval of the record are shown. The items are clearly separated with
their own blocks of information pertinent to that event. The most recent event is shown at the
bottom of the list.

3.8.1 Export the approvals report
To export the displayed approvals report:

1. Click the Export button:
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Figure 3.16 Export approvals report

2. Select the export format. The approvals report can be saved as a PDF, XML or CSV
format.

3. Select where you want to save the exported file.

The example below shows the previous approvals report exported as a CSV file in Excel:

Figure 3.17 Exported CSV

Chapter 3 Regulated environment with OmniTrust



Chapter 4 Sample preparation

4.1 Sample preparation flow chart 62

4.2 Sample preparation 63

4.3 Beaker test guidance 64

4.4 Considerations for sample preparation 66

4.5 Slurries and pastes 73

4.6 Symptoms of poor sample preparation 74

61



62

4.1 Sample preparation flow chart
This flow diagram shows the route taken to prepare an unknown sample:

SAMPLE

Analyze

Analyze

Take Representative Sample
(mix well or riffle if dry powder)

Analyze

Ultrasound if
necessary

Try Surfactant

Ultrasound if
necessary

Ultrasound if
necessary

e.g. Ethanol
Propan-2-ol (IPA)

Methanol
Acetone

Butanone (Methyl Ethyl
             Ketone)

Hexane
Toluene

Dimethyl Digol

Try Solvent

Does it
disperse in

water?

Does it
float?

Does
Ultrasound

work?

Does this
disperse it?

Analyze

Yes No

No

No

No

Yes

Yes

Yes

Figure 4.1 Sample preparation flowchart
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Using liquid-borne particle suspensions, such as latex and emulsions, is usually straight for-
ward. Use the suspension phase as the dispersant, mix the sample well and add directly to the
Mastersizer beaker. Ultrasound is not usually necessary and will almost certainly affect the
size of liquid particles.

Note: Preparation of the sample before it is added to the system is critical. Over half the prob-
lems encountered when measuring a sample are caused by poor sample preparation.
This section discusses some of the techniques available to make sure that the sample
is prepared successfully.

For more information about sample dispersion, refer to the Refractive Index and Dispersants
Guide.

4.2 Sample preparation
Clumps are groups of particles that stick together. They can be tightly or loosely connected. A
typical powder is made up of these clumps, that are held together by weak or strong forces.
The size of the clumps left after the powder is mixed with a liquid partly depends on how much
energy was used to break them apart.

Clumps act like large particles in most particle sizing methods. So, the presence of clumps can
make the particle size distribution appear larger than it actually is.

A particle size analysis is only useful if the sample is prepared in a way that the particles are
well-dispersed. Ideally, most clumps should be fully separated and the particles shouldn't stick
together or to the sides of the container during the analysis.

4.2.1 Representative sample preparation
When taking a sample for a measurement, it is vital to make sure that the sample used is rep-
resentative of the whole sample. This section provides guidelines.

l If the sample is taken from a bottle or container, make sure that it is thoroughly mixed.
When the sample is a powder, large particles rise to the top of the container as smaller
ones work their way to the bottom.
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l In most samples there are some large and some small particles, but the majority fall
between these extremes. If a sample is taken from the top of the container, mainly large
particles will be measured. If this is compared to a measurement with the sample taken
from the center of the container the results will differ noticeably.

l If the sample is stored in a container, mix thoroughly before measurement. Do not shake
the container as this increases the separation of particles. Instead, hold the container in
both hands and gently roll the container, continually changing its orientation for about 20
seconds. This method works better if the container is only half full.

4.2.1.1 Spinning rifflers

If the distribution of particles within a sample is particularly broad, representative sample pre-
paration can be difficult.

A spinning riffler is a vibrating hopper which separates particles, causing larger particles to
travel down the chute before smaller particles. At the end of the chute a set of rotating pans
collects the sample evenly thus containing a representative sample.

4.2.1.2 Liquid samples

Liquid samples can also separate if stored in containers, with larger particles sinking to the bot-
tom. Again, it’s necessary to mix the sample thoroughly to get a representative sample. Sample
splitters/rifflers are also available for liquid samples. Beware of using a magnetic stirrer to mix
a liquid sample as large particles tend to move to the outside of the container due to cent-
rifugal separation, and this can lead to sample biasing.

4.3 Beaker test guidance
Note: The Refractive Index and Dispersants guide provides information on optical properties

and a range of example sample dispersions with suitable dispersant and additive com-
binations. You can downloaded this from www.malvernpanalytical.com.

How you disperse a sample will depend on what you want to measure. If it is important to
quantify the size and extent of agglomeration in a material, then you may need to measure it in
a partially dispersed state. If the primary particle size is important, then the sample must be
completely dispersed to remove any agglomerates. The first step in this process is to choose
an appropriate dispersant. For a laser diffraction measurement, the dispersant should:
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l Provide good wetting of the sample. (enabling dispersion)
l Not dissolve the sample.
l Not contain bubbles.
l Have a suitable viscosity.
l Be transparent to the laser beam.
l Have a different refractive index to the sample.
l Be chemically compatible with the materials used in the instrument.

When you test a new material, you should do a beaker test to check how well different dis-
persants wet the sample. This visual check is quicker than carrying out measurements in a
range of different dispersants. Good wetting between particles and dispersant shows a uni-
form suspension of particles in the liquid, poor wetting may show droplets of liquid on top of
the powder, or significant agglomeration and sedimentation.

4.3.1 Surfactants
How well a powder is wetted by a dispersant depends on the surface tension between the
particles and the liquid. Wetting can therefore be improved by using a surfactant to reduce the
surface tension. Examples of steric and electrosteric surfactants are shown in the following
table:

Table 4.1 Steric and electrosteric surfactants

Stabilization Mechanism Examples

Steric Adding a long chain molecule which
can absorb onto the particle surface

Igepal CA-630, Tween 20/80, Span 20/80

Electrosteric Adding a charged long chain
molecule

Anionic: SDS (sodium dodecylfulfate), AOT
(sodium bis-2-etheylhexylsulfosuccinate)

Cationic: CTAB (cetlytrimethylammonium
bromide)

Surfactants must be added in minute quantities, typically one drop per liter of dispersant. If too
much surfactant is added, the action of stirring and pumping the sample may cause it to froth,
causing bubbles to be introduced into the system. Bubbles are seen by the system as particles
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which can bias the measurement. Anti-foaming agents may be added to prevent the formation
of bubbles but, because these may contain particulates, they should be added to the dis-
persant before the background is measured.

Surfactant can be added directly to a mix of sample and dispersant. However, to avoid any
agglomeration:

1. Add a small drop of surfactant to the sample in a dry beaker and mix into a thick paste.

2. Add the dispersant and mix again.

It is important to control the concentration at which surfactants are used. In general, one to
two drops of a surfactant solution (typically no more concentrated than a few percent w/v) is
sufficient to improve particle wetting. Too much surfactant can cause foaming, and bubbles
which may be interpreted as large particles.

If you are measuring emulsions, then there are two main factors which will aid dispersion.
Firstly, the ideal dispersant would contain the same surfactants and stabilisers present in the
continuous phase of the product.

Ultrasound should not be used on emulsions as this may cause further emulsification, and the
results would not be representative of the product. It is also important to control the speed of
the stirrer in the dispersion unit, as too high a stir speed can cause droplet break up (the effect
of stir speed will also be discussed in the measurement conditions section).

4.4 Considerations for sample preparation
Good sample preparation is critical to the success of a size measurement. Factors to be con-
sidered in the preparation of a sample are:

4.4.1 Solubility
If the material cannot be suspended in a non-solvent, a saturated solution must be used. If this
is the case, any SOP using a saturated solution must state a temperature range at which the
solution is to be prepared and stored. If a suitable temperature range is not stated, crystals
may form or the solution may become desaturated. It is essential to filter the saturate.
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4.4.2 Polarity
The polarity of the liquid medium must be such as not to cause the material to preferentially
adhere to glass surfaces - check this by placing some of the sample material in a small beaker
and then check that it remains in suspension.

4.4.3 Dense materials
If the sample is dense, consider the use of a more viscous medium to buoy the particles up.
However, this is not always a successful approach as the use of a viscous liquid means that
the pump and stirrer speeds need to be reduced to reduce the entrapment of air bubbles. This
reduction in pump and stirrer speeds may result in the material settling out anyway.

If the material gives great problems with solubility, consider the use of the Aero dry dispersion
units. These measure a wide range of particulate materials provided that they are reasonably
free flowing.

4.4.4 Considerations for dry samples
When analyzing a sample, consider the nature of its end use, as this will help determine
whether to analyze it in a wet or dry state. Some samples may react with wet dispersants and
therefore must be measured in a dry state.

Another consideration is whether the material in its dry state is free flowing. Good pouring char-
acteristics indicate a non-cohesive powder which will usually disperse well in a dry powder
feeder without any difficulties, whereas a highly cohesive material tends to stick and clump
together, giving biased measurements.

Remove moisture from a sample by drying it in an oven to overcome sample clumping.
However, care should be taken to avoid damaging it. If it is obvious that using an oven is going
to damage the sample, use a desiccator.

A fresh sample that has not had time to absorb moisture from the atmosphere is always prefer-
able and usually gives better results. If hygroscopic samples need to be conveyed to the sys-
tem over some distances, they should be sealed into pipes as soon as possible with a silica gel
bag if this is practicable.

Note: Application Notes describing how to develop a method for dry sample analysis are
available at www.malvernpanalytical.com.
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4.4.5 Considerations for wet samples

4.4.5.1 Choice and preparation of the dispersant

It is critical to choose the right liquid when analyzing particles suspended in dispersant. The
dispersant can be any clear (at 633 nm wavelength), optically uniform liquid that does not inter-
act with the sample causing it to change its size. When preparing a dispersant:

1. Visually check the dispersion after preparation.

2. Add some dispersant to sample and observe whether it dissolves.

3. If you are unsure on the result, analyze the sample and observe the obscuration figure, if
the obscuration figure decreases the sample is likely dissolving.

The majority of samples will allow water to be used as the dispersant. If the particles are sol-
uble in water or react chemically an alternative must be used. For example, flour added to
water will float on the surface but it disperses well when added to propan-2-ol (IPA).

The dispersant may itself contain impurities or particles that could be significant.

l Malvern Panalytical recommend filtering the dispersant before use either with an in-line
pipe filter or, for small quantities, a disposable syringe.

l Filtration to 1 micron is generally adequate with 0.22 microns being commonly available
and an ideal size.

Consider degassing the dispersant if stored under pressure or at low temperature. Rapid pres-
sure releases or temperature rises could lead to the formation of bubbles, which would be
counted as “particles” in your measurement. Mains water can exhibit this effect: avoid this by
storing a supply at room temperature and pressure for several hours before use. Refer to sec-
tion 4.4.5.5.

Note: The use of cold dispersant in a warmer environment can also give rise to condensation
on the outside surfaces of the cell windows. For systems plumbed into the mains sup-
plies a small header tank may overcome this problem. Filter this water prior to use.
Another solution is to warm the dispersant (for water typically to 60-80 °C) and then
allow it to cool before use.

Chapter 4 Sample preparation



69

WARNING - General hazard
Do not warm a dispersant to allow degassing if the dispersant is volatile. Never allow
dispersants to reach their boiling points.

If condensation is a problem in a water-based system, a quick remedy is the addition of warm
water to the sample tank. The increase in obscuration caused by the condensation will quickly
disappear.

WARNING - General hazard
If solvents have to be used as dispersants follow local procedures for solvent hand-
ling disposal and ventilation.

Whenever difficulties in dispersion are experienced, consider using another dispersant.

Commonly used dispersants

Table 4.2 Dispersant refractive index

Dispersant Refractive index

Water 1.33

Ethanol 1.36

Propan-2-ol (Isopropyl-alcohol) 1.39

Dimethyl Digol 1.41

Butanone 1.38

Hexane 1.38

Acetone 1.36

The cost of some of the organic dispersants may limit their use to the Hydro MV, which typ-
ically only uses 120 ml of dispersant or the Hydro SV, which only needs 7 ml. The problem of
the safe disposal of the sample after measurement must also be considered. Always adopt the
correct procedures for disposing of the sample and dispersant, following any local guidelines.
Most local regulations forbid hazardous samples and dispersants to be tipped down the drain,
allowing them to enter the water system.
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Note: Application Notes describing how to develop a method for wet sample analysis are
available at www.malvernpanalytical.com.

4.4.5.2 Surfactants and admixtures

If experiencing problems such as imperfect wetting where the sample floats on the surface of
the dispersant, the addition of a surfactant or admixture may help.

Surfactants

Add a surfactant to help preparation of the sample as it will lower the surface tension, which
promotes wetting of the particles. Refer to section 4.3.1 for more detail on using surfactants.
Commonly used surfactants are listed in the following table:

Table 4.3 Surfactant information

Surfactant Nature

Igepal™ Non-ionic

Teepol L® Non-ionic

Synperonic® N Non-ionic

Aerosol® OT Anionic (solid)

Sodium dodecyl sulphate Anionic

Hyamine 2389 Cationic

Admixtures

Admixtures work by causing the particle surface to become charged, causing particles to repel
each other (i.e. providing a zeta-potential to aid dispersion). Admixtures are added in larger
quantities, typically one gram per liter. A list of commonly used admixtures is given below:

l Sodium Hexametaphosphate (e.g. Calgon)
l Sodium Pyrophosphate
l Trisodium Phosphate
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l Ammonia
l Sodium Oxalate
l Calcium Chloride

As many of these are solid materials that are dissolved into the dispersant, the solution should
be filtered after preparation to remove impurities.

4.4.5.3 Use of ultrasonics

Ultrasonics can be applied to help a dispersion regardless of whether it contains a surfactant.
Visual inspection of a suspension is often enough to determine whether ultrasonics are
required. If large agglomerates sink to the bottom of a sample, place the beaker of slurry into
an ultrasonic bath for two minutes. Observe whether this has been effective. Further ultra-
sonics can be applied to the tank to prevent re-agglomeration but this is not always needed.

Note: When using ultrasonics with fragile particles, the ultrasonic action may break up the
particles themselves. If in any doubt, microscopic observation before and after the
ultrasonics can establish the impact of the ultrasonics on the sample.

Refer to section 9.7 for more details on using ultrasound and external sonication.

4.4.5.4 Samples with unstable concentrations

When adding the sample to the dispersion unit tank using the software’s Add sample facility,
users may experience obscurations that change during the dispersion period.

It is important to not make any measurements until the obscuration value has stabilized as this
indicates the sample has properly dispersed. When adding very fine materials and relying on
ultrasonics to achieve a good dispersion, add small quantities of sample only. The ultrasonics
will cause the obscuration to rise.

The obscuration and its behavior during the dispersion of the sample can also warn of other
potential problems:

l If the obscuration decreases, the particle size may be increasing. This could be caused
by the sample sticking together, or because the particles are absorbing the dispersant.
Other causes could be the larger particles settling out due to inadequate pumping and
stirring or even the particles dissolving.
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l If obscuration increases rapidly, particles may have attached themselves to the cell win-
dows due to surface charges. This means material is in the laser beam continuously and
the obscuration appears to increase. If this happens, clean the cell windows and use an
admixture to adjust the surface charges present in the sample.

4.4.5.5 Bubbles

Bubbles scatter light which is detected by the Mastersizer, together with the light scattered
from the sample particles. The Mastersizer cannot distinguish between these causes of light
scattering so any bubbles will appear in the particle size distribution. Bubbles vary in size but
are typically around 100 microns in size. In many cases these bubbles can be seen clearly as a
second and separate peak when the measurement data is analyzed. Always be wary of
bubbles in the system.

When the dispersant has been added to the dispersion unit and circulated, we advise stopping
the unit briefly (using the Stop all operations button in the Active Accessory control) to allow
trapped air to escape the system. Also, during installation, make sure there are no twists or
loops in the connected sample pipes.

When adjusting the pump and stirrer speed for a particular sample, make sure the speed is not
so fast that it introduces air into the system.

When a surfactant is added to the sample, excessive speed of the stirrer/pump may cause
frothing. This will force bubbles into the system.

Degas

If dispersant is stored under pressure or at low temperature, degas before use. The pressure
release or temperature rise reduces the solubility of gases, resulting in bubble formation in the
pipes and tank etc. This is a problem with some mains water supplies. To avoid this, store
enough dispersant at room temperature and pressure for several hours before use to allow
degassing to occur. For more information refer to section 4.4.5.1.

Pulses of ultrasonics can help to degas the dispersant after the tank has been cleaned and
filled with fresh dispersant. To do this:

1. Use the Active accessory control panel (Tools > Accessories)

2. Select Enable pulsed sonication.

Note: Make sure that all dispersants are degassed before being added to the system.

Chapter 4 Sample preparation



73

4.5 Slurries and pastes
This section describes two popular methods of adding sample. Refer to section 9.6 for more
details on sample stability and how to solve common issues.

4.5.1 Prepare a slurry
A slurry provides the best control of the sample being added to the dispersant tank when
reaching the target laser obscuration range.

A slurry can be prepared by mixing a small quantity of concentrated sample, dispersant, and
additives. Once the particles have been dispersed, the sample can be added to the dispersion
unit without subsequent addition of surfactants. To prevent the sample settling out in the
beaker:

1. Use a pipette to continually pipette the sample up and down while also stirring.

2. Use the pipette to add sample to the dispersion unit tank.

4.5.2 Prepare a paste
A paste is recommended when measuring a sample which is polydisperse or cohesive. A paste
can be prepared by mixing a small quantity of concentrated sample, dispersant, and additives.
Once the particles have been dispersed, the sample can be added to the dispersion unit
without subsequent addition of surfactants.

The method outlined in ISO 14487 is:

1. Put two drops (or 0,1 g) of the liquid on an etch-roughened glass plate ("frosted" glass).

2. Blend in a roughly equal amount of powder by sprinkling powder on the liquid surface.

3. Rub it into the liquid using a circular motion with a 10 mm wide spatula, applying a mod-
erate amount of pressure.

The objective is to wet all the powder surfaces and to break up all clumps of powder into
primary particles. The high concentration of solids provides crowded conditions that favor col-
lision between clumps and breakup into primary particles. These crowded conditions will also
favor flocculation unless the particles repel one another.
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4.6 Symptoms of poor sample preparation
Use this table to identify sample dispersion problems.

Table 4.4 Sample problems

Problem Symptom Action

Sample dis-
solving

Obscuration
decreases.

Try another dispersant.

Dispersant con-
tains impurities

Poor back-
ground read-
ings.

Filter the dispersant before use.

Bubbles within
the dispersant

Bubbles typ-
ically show as a
secondary
peak at 100
microns.

Degas the system.

Sample floating
on the surface of
the dispersant

Sample seen on
the surface of
the dispersant
in the tank.

Add surfactant or admixture.

Sample clumps
together

Obscuration
decreases.

Add surfactant or admixture, or use ultrasound.

Sample sinks to
the bottom

Obscuration
decreases as
the larger
particles settle
out.

Increase the pump/stirrer speed.

Sample swells in
dispersant

Obscuration
decreases.

Try another dispersant.

Particles sticks
to the windows

Rapidly increas-
ing obscur-
ation.

Clean the windows.
Use an admixture or surfactant.
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Problem Symptom Action

Condensation on
the cell windows

Rapidly increas-
ing obscur-
ation.

If (and only if) the dispersant is water, add a quantity of hot (not
boiling) water to the tank. If the obscuration falls, condensation
is the problem.

Bubbles sticking
to windows

Difficulty in
obtaining low
background
despite many
rinses.

Drain the sample tank. The bubbles will burst. Fill the system
carefully with degassed dispersant. In a new system, adding
Decon 90 to the tank overnight and rinsing 7 or 8 times will wet
out the cell surface and reduce bubble formation.
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5.1 Measurement types
The Mastersizer can make two types of measurement:

5.1.1 Manual measurements

l Manual measurements tend to be used as part of method development to
establish optimal settings for a measurement before saving as an SOP.

l All of the measurement settings are specified before the measurement.
l Some further input is required throughout the measurement.
l The measurement process itself is split into key stages which are paused after

completion of each stage.

5.1.2 SOP measurements

l The majority of measurement settings are stored within an SOP file which was previously
created.

l Once an SOP is initiated, little user input is required.
l SOPs improve consistency and repeatability of measurements which is important in qual-

ity-controlled environments.

If a particular SOP is consistently re-used as the basis for other SOPs, make an SOP template
using those settings. Refer to Chapter 10.

5.2 Measurement display overview
The measurement display allows you to control the measurement sequence once started. Also
refer to section 5.7.2 or section 5.6.1.

5.2.1 Sequence options and progress bar
The measurement sequence consists of several processes that constitute a complete meas-
urement. These steps are presented in the sequence bar at the top of the window. The fol-
lowing example is for a wet measurement:
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Figure 5.1 Sequence bar

Tip: After the sequence is complete, double click on the appropriate step button to start
any individual process separately. This feature is more useful in wet measurements,
where the sample is in continuous circulation, rather than in dry measurements, which
are usually a single long-duration controlled by obscuration filtering.

Controls provide functions to start and stop a process, as well as return to the measurement
settings. Further information is also displayed about what to do next and the progress of the
measurement.

Table 5.1 Measurement sequence buttons

Button Function

Start currently active process - for example, Measure Sample.

Stop currently active process.

Access measurement settings (manual measurements only).

The following steps are typically shown in a measurement:

Pre-Clean system - initiates a pre-cleaning cycle on the instrument.

Initialize Instrument - the system's optical alignment is set - either manually or automatically.

Measure Background - the system measures the red, then the blue background light values
without sample in the cell.

Measure sample - wet measurement: add sample until the obscuration is within the correct
range (refer to section 9.4). In a dry measurement the system will skip this step.

Sample measuring - the system measures the red, then blue light values of the sample. The val-
ues measured are shown in the Trend view. When complete, the system pauses.
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Clean System - initiates a cleaning cycle on the instrument.

5.2.1.1 Optical alignment

During the Initialize Instrument process, you can set the alignment to automatic or manual.

1. Click the arrow to the right of the Initialize Instrument icon.

2. Select either Automatic or Manual.

3. For manual, use the arrows to adjust the alignment:

Figure 5.2 Manual alignment pop-up window

Note: You should only use manual alignment if you are experienced in using the instrument.

Once set to manual, you will be prompted to set the alignment each time you make a
measurement. Reset the alignment to automatic if you don't want to do this step for
every measurement that you run.

5.2.2 Result view
The Result view shows the Laser, Light Scattering, Size Distribution and Percentiles panels.
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Figure 5.3 Result view

The Result view displays either Live information or Information relating to a selected record
after measurement completion.

The panels are:

l Laser - initially provides an indication of the current Power output of the laser. During the
sample addition phase, the current Obscuration level is shown. When adding sample the
obscuration should fall within the green band (defined in the Measurement obscuration
settings).

l Light Scattering - provides a live graph showing the Energy plotted against Detector
Number. This is available as a live display before the measurement is initiated. Following
the measurement this panel contains the data recorded at the measurement time.

l Size Distribution - plots Volume (%) against Particle Size (µm). After a measurement
has run, data from the selected measurements can be selected by dragging the yellow
bar in the trend view.

EXTENDED FEATURE - The light scattering and size distribution views can be tiled adjacently by
clicking .
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5.2.3 Trend view - EXTENDED FEATURE

The Trend view is an analytical tool that shows measurement data in a graphical format as
soon as it has been measured by the system.

Figure 5.4 Trend view

Each measurement is given a Dv10, Dv50 and Dv90 figure, making it simple to quickly assess
your result. Most particles measured fall into the Dv50 category.

After the measurements have run, you can select multiple records and then view combined fig-
ures for the selected range. You can also modify the data shown on the graph, and add
entirely new graphs with a different focus of interest if needed. This is an example of the trend
view after four measurements have been made. The currently selected range in this example
includes two records: Record Number 2 and 3 - the values displayed relate only to those two
records.

5.2.3.1 Statistics shown in the live trend view

The live trend view identifies each line with a key, which shows statistical information about
the measurement:

Figure 5.5 Statistics in the live trend view
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The data shown relates to the individual measurement or range of measurements selected by
the user. The default view shows particle size statistics. Trend plots can be configured to
show any parameter. The statistics shown on a plot line relate to a single parameter only.

l Main figure - the actual size measurement (µm) for the single base record that is cur-
rently selected (Dv10 - blue, Dv50 - green, Dv90 - red).

l Av - the average particle size (µm) for the selected range.
l RSD - Relative Standard Deviation (%) for the selected range.

Modify statistics shown

1. Right-click anywhere on the trend graph and choose Statistics.

2. Select or deselect the items you require from the list.

Tip: Click anywhere on the graph line to display data points - click again on the line to
remove them. Move the mouse pointer over a data point to display its record number
and size figure, for example 4, 891.09 indicates that Record 4 has a measured size of
891.09 µm.

5.2.3.2 Select a range of records

After running several measurements, just one record is selected. Initially this is the last meas-
urement made. This record is shown by a vertical hairline bar with the record number indicated
at the bottom - for example, . The vertical hairline bar always shows the currently selected
record.

l To expand the range to incorporate more records: Click the left or right selection arrow
buttons at the top of this bar. The bar expands to cover the records selected:

Click and drag this header bar to the left or right to reposition the selection within the
range of records. Alternatively, right-click on the trend graph and choose: Statistics
range and then select the number of records to include in the selected range.

l To contract the range: Click and drag the left hairline bar that denotes the first record in
the selected range. Alternatively, right-click on the trend graph and choose: Statistics
range and then select the number of records to include in the selected range. If you have
manually dragged the bar to cover several records not listed in the Statistics range menu,
Custom and the number of records currently selected is displayed.
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All numerical data then provided is the arithmetic mean of the currently selected records, apart
from the initial particle size figure, which is still the figure for the single record.

5.2.3.3 Add further charts

The trend view can be configured to contain further parameter information on separate col-
lapsible charts.

1. To add a new chart, right-click on an existing trend graph and choose Add above or Add
below. Alternatively, right-click on the white-space around an existing graph and select
New chart.

2. Now add parameters using the Parameter Selection window. Any items with numeric val-
ues, such as Dv x can be modified, once in the Selected list, by clicking on the numeric
value and editing it as required (for example to Dv 10, Dv 20, Dv 30 etc.).

Tip: To improve readability, select a small number of parameters.

5.2.3.4 Re-configure an existing chart

Right click a chart and choose Configure to display the Parameter selection window .

l Displaying multiple charts in the Trend view can present too much data for easy reading.
To expand a single chart, collapsing the others, click on the header area for that
chart. To contract the chart again, click .

l To move a chart up or down, right-click it and choose Move up or Move down.
l To remove a chart that is no longer needed, right click on it and choose Delete.

5.2.4 Tabbed panel controls - EXTENDED FEATURE
The tabbed panel provides quick access to several functions within the software:

l Accessory controls panel - allows you to specify the various operational parameters of
the dispersion unit, for example stirrer speed. Refer to section 5.3 for further details.

l Sample documentation - the sample name and any further fields specified in the meas-
urement settings. Refer to section 5.2.5 for further details.

l Log - a chronological list of all events performed during the current measurement.

Chapter 5 Measurements



85

l Simulator - enables you to specify simulation mode settings. This mode allows the soft-
ware to run test measurements without having an instrument connected. Refer to section
5.2.6 for further details.

l Data Quality - an indication of the data quality of the background and sample meas-
urement, with possible causes and advice to improve the quality. Refer to section 5.2.7
for further details.

5.2.5 Sample documentation - EXTENDED FEATURE
The Sample documentation tab in the Measurement display window provides quick access to
view or edit the sample identification information as set up in the Manual measurement set-
tings.

This process requires the software to be in Manual measurement mode - refer to section 5.6
for more information.

1. Select the Sample documentation tab from the right panel. The sample name and any
other fields defined in the Sample - Identification section of the Measurement settings
window are listed. Refer to section 10.2.1.

2. These fields can be edited prior to starting the measurement.

Note: If specified in the SOP settings the system will prompt you to enter and confirm sample
documentation when the measurement starts. The system then automatically moves
to the Measure Background stage.

5.2.6 Measurement simulator
The Measurement simulator settings in the Measurement display window allow the fine tuning
of the simulation mode's parameters.

The measurement simulator is used mainly for demonstration purposes, but it can be helpful
when familiarizing users with the functionality of the software, without the need to have an
instrument connected.

1. To activate the simulator click on the connected instrument icon on the status bar and
choose Load simulator, then select the mode in which you wish to run the simulator.
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Figure 5.6 Select Load simulator in the simulator selector

The software is now in simulation mode, which is shown on the status bar:

Figure 5.7 Simulation mode indicator in status bar

2. To swap to a different accessory simulator click on the simulated icon instrument and
select as required.

5.2.6.1 Measurement simulator controls

In simulator mode accessory controls can be set independent of a connected instrument. No
accessory selected will be shown connected under the accessory control tab.

Figure 5.8 No accessory connected shown in control tab

1. From the Measurement display window, click the Simulator tab on the right.
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Figure 5.9 Measurement simulator tab

Note: The software must be in simulation mode for this tab to be displayed.

2. Set a value of between 0–100 for each of the following settings. The value is shown as a
tool tip when the mouse is placed over the slider bar.

l Laser Power - use the slider bar to simulate different levels of laser power (leftmost
is least power).

l Signal Level - use the slider bar to simulate different levels of sample light scat-
tering.

l Background Level - use the slider bar to simulate different levels of background
noise (leftmost is least noise).

5.2.6.2 Additional Simulator

Once the simulator mode is active, a second simulator is available, where specific simulated
accessories can be selected. The accessory controls will be visible in the accessory control
tab and the Measurement settings window.

1. Click on the Manual Accessory icon on the status bar and select the accessory type
required.
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Figure 5.10 Select the accessory type required

2. The software is now in simulation mode, which is shown on the status bar:

Figure 5.11 Simulation mode shown in the status bar

3. Any connected instrument is not used in the measurement process whilst in this mode.

5.2.7 Data Quality Guidance - FEATURE KEY
Click the Data Quality tab in the Measurement display window to view any data quality issues
that are detected as a measurement is running:

Figure 5.12 Data Quality tab

The Mastersizer software detects a comprehensive range of data quality issues for the back-
ground measurement and sample.
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Figure 5.13 Data quality displayed while running a measurement

Background analysis includes checks for:

l Peak
l Spike
l Instability
l High signal
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Sample analysis includes checks for:

l Obscuration
l Alignment
l Negative data
l Data fit
l Optical model
l Fine powder mode

Click on any issues to display more detail on the likely cause of the issue and advice on how to
resolve the problem.

Figure 5.14 Data quality detail and advice

Note: The display only shows when there are any issues detected.
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When the entire set of measurements is complete, more information is displayed on the data-
set variability. These checks include:

l ISO variability
l USP variability

Figure 5.15 Data variability advice
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5.3 Accessory controls panel - EXTENDED FEATURE
Note: Users with the Basic software feature set control the dispersion unit with the Accessor-

ies option on the Tools ribbon.

Use the Accessory controls panel from the manual measurement mode to control the attached
accessory independently of the measurement process. This is useful when observing the
effects of variation to the accessory's settings on the Live laser and Light Scattering panels, in
order to optimize the sample's concentration and circulation prior to making a measurement.
This option could also be used as part of a manual cleaning process.

l Select Manual Measurement mode.
l Click the Accessory controls tab on the right. Each section can be collapsed to save

space on the Measurement window.

Figure 5.16 Accessory controls tab

For a description of the accessory control options for each dispersion unit:

l Hydro LV/MV - refer to section 5.3.1
l Hydro SV - refer to section 5.3.2
l Aero S - refer to section 5.3.3

Note: If required, click Stop to stop all operations and close all valves. The accessory is
returned to the standby status.
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Tip: The controls are also available from the Active accessory control feature (Select Tools
> Accessories).

5.3.1 Accessory panel - Hydro LV/MV
This section describes the Accessory control panel settings for the Hydro LV/MV and Hydro
EV.

Figure 5.17 Accessory control panel
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5.3.1.1 Dispersant

Sensor reading and threshold

Note: Only for Hydro MV/LV units that are fitted with an analog sensor - MAP3210/3310.

The Sample – Dispersion SOP window contains a level sensor threshold field where a value
can be inputted that is suitable for the level sensor to detect the dispersant level when filled.
The value will be different for each dispersant used. Refer to section 10.4.

Figure 5.18 Level sensor threshold

The Hydro MV requires additional actions to be carried out before it can be correctly used with
any dispersant other than water. The threshold value to be used in the SOP will first need to be
set up using the threshold controls in the Accessory controls window, and then stored in the
Dispersant database for use later.

Note: Threshold setting can be done as part of a manual measurement and for any SOP
method development.

To set the threshold:

1. Select a dispersant from the Database. If the selected dispersant does not have a valid
level sensor value then the threshold control will turn blue, together with a Tank full con-
firmation button , to indicate the value needs setting.

2. Fill the tank manually to the level of the tank baffle.

3. Click the Tank full confirmation button. This button is grayed-out until the sensor reading
value is greater than zero. Automatic fills are also disabled until the threshold has been
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set.

4. Once the Tank full confirmation has been selected the threshold control will clear and
automatic fills are now possible.

Figure 5.19 Set threshold

When the dispersant is now selected in the Sample dispersion window, the new threshold
value will be used. Refer to section 10.4.

Fill

Fills the Hydro unit tank with dispersant. How the tank is filled depends upon the fill options
selected.

Automatic fill

This is the default selection and allows back-compatibility with previously created SOPs. In
this mode, the function opens the internal dispersant valve (and external valve if configured)
and then pumps dispersant into the unit until the correct level is reached (detected by a
sensor) and then closes the dispersant valve.

Note: If using this option, it is advised that only one supply is connected to the accessory to
prevent the two dispersant supplies mixing inadvertently.

To prevent overfilling, if the chosen dispersant has a level sensor threshold of 0 (zero), the Fill
button command will be disabled when the Automatic fill option is selected. The threshold
value must be set for the Fill button to become enabled.

Figure 5.20 The tank indicator
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The tank indicator next to the Fill button shows full and empty respectively. This indicator can
be used when the tank is manually filled.

Manual fill

Manually fill the tank slowly until the indicator shows full - this will indicate the correct fluid
level for sample addition and running measurements. If the tank is filled higher than this,
sample and particles may be lost via the over-flow system. This will lead to an incorrect
particle size distribution being reported.

Automatic fill (internal)

This fill mode uses the lower internally regulated dispersant inlet port to fill the tank. This is nor-
mally used for aqueous dispersants. As with Automatic fill above, this mode opens the dis-
persant valve, pumps dispersant into the unit until the correct level is reached and then closes
the dispersant valve.

Automatic fill (external)

This fill mode uses the upper externally regulated dispersant inlet port to fill the tank. This is
normally used for non-aqueous dispersants.

There is no internal regulator controlling the dispersant input. It is therefore recommended that
the supply to this inlet is enabled and controlled using an external pump and cable. Refer to
the Hydro Series Wet Dispersion Units guide for details on using an external pump.

This mode will work like Automatic fill above, except an external pump or regulator is used to
control the flow of dispersant into the unit. When the correct level is reached, the external
pump (or regulator) will be stopped.

Degas after Fill

Select Degas after Fill to remove any bubbles and dissolved gases from the fresh dispersant
before use. This pulses the ultrasonics for a period of time after the tank is filled.

Empty

Empties all dispersant (and sample) from the Hydro unit.

This function opens the drain valve and initiates a pump sequence. The sequence stops when
the unit is empty and the drain valve is then closed.
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5.3.1.2 Stirrer

Note: Only Hydro MV/LV and Hydro EV units.

Use the slider bar to set the speed (RPM) of the stirrer. In Manual Measurement mode it is
necessary to start the stirrer manually before making the measurement.

To initiate the stirrer once the speed has been set, click the Start button. To stop the stirrer
click the Stop button.

The sliders change to show the difference between the requested and actual speeds.

Table 5.2 Stirrer graphics

Graphic Meaning

The gray bar shows the requested speed.

The actual speed is less the requested speed. This
will normally be seen during a fill operation.

The actual speed is equal to or slightly more than
the requested speed. This will normally be seen dur-
ing a measurement.

Note: There will be a small lag as the actual speed adjusts to match the requested speed.
The optimal stirrer speed is normally a choice between a fast speed that ensures that
all the sample is suspended, but not so fast that bubbles occur.
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5.3.1.3 Ultrasound

Note: Only Hydro MV/LV and Hydro EV units.

Manual/Timed

Select the Manual option to start and stop the ultrasound manually for a period of time.

Select the Timed option to perform a precisely timed period of ultrasound application. When
Timed is selected, the timer controls become available - click +/- to increase/decrease the
time period for which ultrasound will be applied.

Figure 5.21 Timer controls available

Continuous/Pulsed

In Continuous mode, sonication is applied continuously. Choose an appropriate level of ultra-
sound for the sample with the slider bar.

In Pulsed mode, sonication is applied in pulses (with fixed duration on and off pulses).

This option can be used in combination with both continuous or timed sonication mode. Enter
the required values (seconds) into the On time/Off time boxes to specify the duration of on
and off pulses.

Figure 5.22 Choosing pulse intervals

In both modes the elapsed time is displayed. Press to reset the clock.

5.3.1.4 Valves

Note: Only for Hydro MV/LV units.
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Drain valve

l Opens/closes the drain valve.

This will allow any dispersant and sample in the system to drain naturally. No pump is applied,
so this process will not completely void the system to the same extent as the Empty function.
This could be useful if, for example, the system had been manually overfilled and needed
some adjustment of the level.

Dispersant valve

l Opens/closes the dispersant inlet valves.

Control the valve in this way to allow a manual fill to be done using the dispersant inlets.

This might be required to only add a certain amount of dispersant, without use of the level
sensor, or if the system had been partially drained (with the Drain valve option) and then needs
to be manually topped up.

Three valve options are available:

l Auto - (default) allows back-compatibility. In this mode, the function opens the internal
dispersant valve (and external valve if configured).

Note: With this option, it is advised that only one supply is connected to the accessory to pre-
vent the two dispersant supplies mixing inadvertently.

l Internal - uses the lower internally regulated dispersant inlet to fill the tank.
l External - uses the upper externally regulated dispersant inlet to fill the tank.

Note: It is important that the valve is closed. The valves are not closed automatically with
this option. The tank will continue to fill until manually closed.

5.3.1.5 Clean

Note: Only for Hydro MV/LV and Hydro EV units.
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Select the clean sequence required: Quick (1 clean cycle), Normal (3 cycles), Extensive (5
cycles). The dispersion unit will perform a clean sequence, for the selected duration, that will
remove any sample that remains in the sample path.

To start the clean cycle, click the Clean System button:

Figure 5.23 The Clean system button

For the Hydro LV/MV - for a description of the tank fill behavior and degas functions, refer to
section 5.3.1.1.

Note: In the Active accessory control window (Tools > Accessories) click Clean to start
the clean sequence.

5.3.2 Accessory panel - Hydro SV
Accessory control panel settings for the Hydro SV.

Figure 5.24 Accessory control panel - Hydro SV

5.3.2.1 Stirrer

Use the slider bar to set the speed (RPM) of the stirrer. In Manual Measurement mode it is
necessary to start the stirrer manually before making the measurement.

To initiate the stirrer once the speed has been set, click the Start button. To stop the stirrer
click the Stop button (or alternatively push on the speed control dial on the unit).

Note: The software stirrer slider bar, and the SV front panel manual control dial are syn-
chronized. Movement of the slider bar will alter the front panel display and vice versa.
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The stirrer speed can be controlled from the software when the instrument is not installed into
the instrument cell bay, but only when the dispersion unit is 'active', as indicated on the status
bar.

5.3.3 Accessory panel - Aero S/M
Accessory control panel settings for the Aero S/M.

Figure 5.25 Accessory control panel- Aero S/M

5.3.3.1 Disperser/Tray configuration

Note: Only for Aero S units.

Displays the configuration of the dispersion unit.

l Venturi type - the type of venturi currently installed in the dispersion unit.
l Tray type - the tray type currently in use.
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5.3.3.2 Action buttons

l Standby - by default the Aero is in standby mode when the accessory is connected and
powered up, but not active. In this mode the front LED is pulsating.

l Flow - activate the air flow.
l Feed - starts the vibrating feed tray. Selecting this option also automatically turns on the

Air Flow.

5.3.3.3 Air pressure

Use this slider bar to set the air pressure at which the sample is circulated (from 0 to 4 bar, in
0.1 bar increments). Lower air pressures can be better for fine or fragile particles, higher air
pressures for agglomerates or metallic particle samples.

5.3.3.4 Feed rate

This controls the vibration speed of the feed tray. Use the slider bar to set the rate at which
the sample is fed into the system. The correct feed rate is one at which the sample is vibrated
evenly along the feed tray and gives the required obscuration. This rate is best established as
part of a method development process.

5.3.3.5 Clean

Note: Only for Aero S units.

Select the clean sequence required: Quick (5 secs), Normal (10 secs), Extensive (15 secs). The
dispersion unit will perform a clean sequence, for the selected duration, that will remove any
sample from tray and the disperser.

A Custom vacuum sequence can be configured. Clean duration, air pressure and feed rate set
as appropriate for the sample and application.
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Figure 5.26 Custom vacuum sequence

To start the clean sequence, select the Clean System button.

Note: In the Active accessory control window (Tools > Accessories) click on Clean to
start the clean sequence.

The Vacuum can be turned on or off as required. i.e. if the material used to clean is to be kept
instead of it going into the vacuum.

5.3.3.6 Abort

Stops all operations and closes all valves. The accessory is returned to the standby status.

5.4 Materials Database
The materials database contains a list of materials and their optical properties which can be
applied to a measurement to help improve its accuracy. You can search, edit, add, or remove
materials from the database. A small number of predefined materials are already in place -
these cannot be edited or removed.
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Any materials that you add to the database are indicated with the user added icon and
can be modified or deleted.

When running a manual or SOP measurement, a Material name is requested. If the material has
previously been added to the database, it can be selected from the Materials Database, which
automatically completes the rest of the Material properties required for the measurement. It is
also possible to enter the details of the material at measurement time and then save those
details into the Materials Database for further use.

Note: If the same type of material is likely to be measured several times, it should always be
added into the Materials Database.

5.4.1 Access the Materials Database
Click on Materials database from the Materials and dispersants group on the Tools ribbon.

Figure 5.27 Access the Materials Database

Items in the Materials Database are listed alphabetically. Click an item in the list to display a
summary of all its properties at the bottom of the window, including Blue-light properties, if
these have been entered.

Note: EXTENDED FEATURE - there is a search box function to search the materials database.

The following information needs to be entered into the database:
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l Material name - a descriptive name for the material.
l Refractive index (RI) - value of between 0 and 5. This value relates to the speed of light

within the material, which in turn allows the degree of refraction (light bending) to be pre-
dicted when light passes from one medium to another.

l Absorption index (AI) - a value between 0 and 10, which is a measure of the quantity of
light absorbed by the particles. Generally, clear samples will have a low or zero absorp-
tion while colored or black samples will have a higher value.

l Density - a value of between 0.001 and 25 g/cm³.
l Different blue-light properties - if required, add the RI (blue-light) and AI (blue-light).
l References and notes - enter any further comments that help to describe the material.

5.4.2 Add and edit material
To add new items to the Materials Database you need to know the optical characteristics of
the material in question. Many of these are available in the Refractive Index and Dispersants
Guide, which can be downloaded from the Malvern Panalytical website.

1. Click the Add button to display the Edit Material Properties window.
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Figure 5.28 Edit Material Properties

2. Enter the properties for the Material (refer to section 5.4).

3. Click OK when all required settings have been entered. The new item is added to the bot-
tom of the list.

5.4.2.1 Edit or remove materials

Note: Only items with the user added icon can be edited/removed.

l To edit an item: Highlight the item you wish to modify and click the Modify but-
ton to display the Edit Material Properties window. Edit any of the details as required and
then click OK.

l To remove an item: Select the item you wish to remove from the list and click the Remove
button. The system asks for confirmation of this request. Click Yes to remove

the item permanently from the Materials Database.
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5.5 Dispersants Database
The dispersants database contains a list of dispersants and their optical properties which can
be applied to a measurement to help improve its accuracy. You can search, edit, add, or
remove dispersants from the database. A small number of predefined dispersants are already
in place - these cannot be edited or removed.

Any dispersants that you add to the database are indicated with the user added icon and
can be modified or deleted.

When running a manual or SOP measurement, a Dispersant name is requested. If the dis-
persant has previously been added to the database, it can be selected from the database,
which automatically completes the rest of the Dispersant properties required for the meas-
urement. It is also possible to enter the details of the dispersant at measurement time and then
save those details into the Dispersants Database for future use.

Note: If the same type of dispersant is likely to be used several times, it should always be
added into the Dispersants Database.

5.5.1 Access the Dispersants Database
From the Materials and dispersants group on the Tools ribbon, select the Dispersants Data-
base button.

Figure 5.29 Accessing the Dispersants database
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Items in the Dispersants Database are listed alphabetically by default. To list the items by
optical property, click one of the column headings. Highlighting an item in the list (by clicking
on it with the mouse) displays a summary of its properties at the bottom of the window.

For information on how to use the Dispersants Database refer to section 5.5.2.

Note: EXTENDED FEATURE - there is a search box function to search the materials database.

The following information needs to be entered into the database:

l Dispersant name - a descriptive name for the dispersants, for example, Ethanol.
l Refractive index - value of between 0 and 5. This value relates to the speed of light

within the material, which in turn allows the degree of refraction (light bending) to be pre-
dicted when light passes from one medium to another.

l Level sensor threshold (only for Hydro MV/LV units that are fitted with an analogue
sensor - MAP3210/3310) - A value can be inputted that is suitable for the level sensor to
detect the dispersant level when filled. The value will be different depending upon the
dispersant used.

l References and notes - enter any further comments that help to describe the dispersant.

5.5.2 Add and edit dispersants
Before adding entries to the Dispersants Database , you will need to know their optical char-
acteristics.

5.5.2.1 Add dispersants

1. From the Materials and Dispersants group on the Tools ribbon, select the Dispersants
Database button.

2. Click the Add button to display the Edit Dispersant Properties window.
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Figure 5.30 Edit Dispersant Properties

3. Enter the properties for the Dispersant (refer to section 5.5).

4. Click OK when all of the fields are complete. The new item is added to the bottom of the
list.

5.5.2.2 Edit or remove dispersants

Note: Only items with the user added icon can be edited/removed.

l To edit an item: highlight the it and click the to display the Edit Material Prop-
erties window. Edit any of the details as required and then click OK.

l To remove an item: select it from the list and click the . The system asks for con-
firmation of this request. Click Yes to remove the item permanently from the Dispersants
Database.
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5.6 Manual measurements
The process of setting up a manual measurement is:

l Start a manual measurement. Refer to section 5.6.1 for details.
l Set up the manual measurement or use an SOP. Refer to section 10.1 or section 5.6.2.
l Step through the measurement sequence overview in the helpfile.
l Observe the Trend view panel and refine the measurement or accessory settings (the

accessory control panel is useful for quick adjustments) before making further meas-
urements. Refer to section 5.2.3 for more information.

5.6.1 Run a Manual measurement
Manual measurements follow a sequence of events: alignment, background measurement,
adding sample (wet measurements only), sample measurement and cleaning. The system
pauses between each of these stages and prompts you when intervention is required.

1. Click Manual measurement in the Measurements group of the Home ribbon.

Note: The Manual measurement button is only shown if a dispersion unit is connected
to the instrument, or the instrument is in simulation mode.

2. Configure the measurement settings and then click OK.

Note: In manual measurement mode you can control the accessory manually at any
time using the Accessory controls panel.

3. From the Initialize Instrument menu, select the required alignment mode - Automatic is
the default.

l For automatic alignments, the alignment is performed by the system.
l If you select manual alignment, adjust the settings in the pop-up Manual

Alignment window, and close the window when complete. Refer to section
5.2.1.1.

4. Click Start to measure the light background.
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l For a wet measurement both the red and blue light measurements are
made.

l For a dry measurement, only a red light measurement is performed. When
this process is complete, the software pauses again.

Note: To reconfigure the measurement settings at any time during the measurement, click
. To stop one of the measurement processes whilst in progress, click .

5. Wet measurements only - add sample until the obscuration is in range, observe the
effect in the Laser display's Obscuration bar. Refer to section 9.4. If required, make fur-
ther manual measurements by clicking Start again. Measurements will accrue in the
Trend view.

6. Dry measurements - use a single measurement of long duration with obscuration fil-
tering. This automatically starts the measurement when the obscuration is in range and
stops when the obscuration falls below a certain level.

7. After the measurement has completed, you can optionally start the cleaning cycle by
double-clicking Clean System.

8. When you have made all the measurements required, close the Measurement display win-
dow to return to the Record view.

5.6.2 Manual measurements using SOP settings
Use an existing SOP/template to pre-fill a manual measurement's settings to save time and
improve consistency.

To improve consistency and save time, it's best to modify an existing SOP or template, rather
than create a new one from scratch.

1. Click Manual measurement in the Measurements group of the Home ribbon.

2. Select File > New from the Manual Measurement Settings window. The system informs
that the current settings will be lost - click Yes. The New SOP window is displayed, which
presents the existing templates available that apply to the currently connected or sim-
ulated accessory.

3. Select one of the templates or click From existing SOP... to select an SOP file. The set-
tings of that SOP or SOP template are then used in the Manual measurement settings win-
dow.
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5.7 Standard Operating Procedures (SOPs)
SOPs provide a reliable means of automating measurements to ensure consistency and repro-
ducibility of measurements across various users. An SOP can control many aspects of a meas-
urement such as user instructions, optical unit configuration, and dispersion unit configuration.

The quality of an SOP depends on the quality of the method development process that was
undertaken to produce it. A number of standard SOPs have been prepared in advance for typ-
ical measurements, which may be used unchanged or as the basis for new procedures.

The Mastersizer software's powerful SOP editing facility enables users to review and refine
SOPs as part of their ongoing quality control process.

5.7.1 Create and Edit SOPs
The process of creating SOPs and editing existing SOPs is very similar.

1. To create a new SOP click New > SOP from the Documents group on the Home ribbon (to
edit an existing SOP, click Open > SOP instead).
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Figure 5.31 New SOP template

1. Select an SOP template from the list in the New SOP window. Alternatively click From an
existing SOP... to locate an existing SOP that is functionally similar to your required cri-
teria.

2. The SOP Editor window is now displayed. This will be configured to apply to the dis-
persion unit selected.

3. Step through the SOP Editor completing each of the sections (refer to Chapter 10):
l Sample settings
l Measurement
l Sample dispersion settings
l Data processing settings
l Output
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4. When the required settings have been specified, save the SOP as a file or as a template
.

l To save as a file, click File > Save and then give the SOP a logical name.
l To save the SOP as a template, click File > Save as template. The Save SOP Tem-

plate window is displayed.

5. Enter a Name and Description. If required, add a category (previously added categories
are available from the menu) - this could useful if your environment has multiple SOP tem-
plates. Allow new template to override any existing template will override any existing
template (make sure the new template uses the same name as an existing template to
save over it).

5.7.2 Run an SOP measurement

1. Click Run SOP from the Home ribbon.

2. The SOPs shown are filtered for the connected accessory ( Accessory filtered).
Deselect this filter to show all SOPs.

3. To find a specific SOP or range of SOPs or use the search function.

4. Select an SOP and click OK.

5. The Measurement Display window contains a progress and status indicator at the top of
the window. This provides prompts on what to do next. Follow the instructions provided.
Some stages require user intervention.

6. Whenever the Start button is active, click it to initiate the next part of the sequence.

7. When all the measurements specified in the SOP have completed, close the Meas-
urement Display window to view the results in the Record view.

5.7.3 SOP templates
SOP templates allow you to create SOPs based on predefined settings, improving both the
speed of creation and consistency. Effectively SOP templates are just SOPs with additional,
optional, metadata attached to them - a Name, Description, Category and Image. If the core
settings of an SOP are to be used frequently, it is advisable to create an SOP template with
these settings.
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You can create an SOP template in one of two ways:

l Create an SOP from scratch and save as a template.
l Open a previously created SOP template, make amendments to it, and then save it.

SOPs can be edited, saved as new templates, or saved as standard SOPs.

Note: SOP Templates are stored as .msot files in the Windows file structure. If required, use
the Workspace shortcut from the Workspace Viewer panel to locate the SOP Template
folder (the templates are organized in folders based on any categories that users have
assigned to the templates). If any associated image is removed from the SOP Tem-
plate folder, a default image is used instead.

5.7.3.1 Create a new SOP template

1. From the Home ribbon select New > SOP.

2. Select the appropriate template from the list (or From existing SOP...) and click OK.

3. Edit the SOP details as required and then choose File > Save as template.

4. In the Save SOP Template window, give the new SOP template a (descriptive) Name ,a
description, and if required, assign a category (previously added categories are available
from the drop-down menu). Categories could be of assistance when your environment
has multiple SOP templates. Additionally, an image can be assigned to the template:

l to assign a custom image.
l to restore the template default image.

5. To save over an existing SOP template (i.e. to edit an existing template), select Allow new
template to override any existing template from the Save SOP Template window. Also,
make sure that the new template uses the same name as the existing template.

Tip: To view a set of pre-selected SOP templates based on the current accessory type,
choose File > New from the Manual Measurement settings window.

5.7.4 SOP player - EXTENDED FEATURE
The SOP player lets you run multiple measurements on a single sample using different meas-
urement and/or analysis settings.
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Figure 5.32 Open the SOP player

To set up an SOP playlist:

1. Create a set of SOPs for the dispersion unit they want to use that contain the meas-
urement settings required for the sequence.

2. Select the SOP Player option from the Home ribbon bar, the SOP Player window will
open.

The SOPs available for use in a playlist are shown on the left of the SOP Player window, with
the current playlist shown on the right. The details for any selected SOP are provided in the
bottom section of the player, allowing users to confirm the settings the SOP file contains.

To add SOPs to the player:

1. Select SOPs from the available SOPs list and drag them into the SOP playlist. Altern-
atively use the button.

2. SOPs can then be dragged up and down into the final position or deleted from the list
using the button. As the playlist is constructed, messages will appear to help the
users organize the finished playlist (e.g.: Drag and drop SOPs here to create a playlist /
The SOP does not match the target accessory type).
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Table 5.3 SOP Player icons

Icon Description

Changes the currently opened folder

Adds the current folder to the workspace window

Opens the folder browser window

Accessory filter - hides SOPs that do not match the
connected dispersion unit

Switches the view between icons or detail view

Name of the playlist and the target dispersion unit

Create a new playlist

Opens a saved playlist

Saves the active playlist

Search function to find a specific SOP or range of
SOPs
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Figure 5.33 SOP player

In the illustrated example, we have added two SOPs to the playlist.

l SOP playlists can be opened and saved using the options at the top of the SOP
playlist. Playlists do not have to be saved before they are run, but a prompt will be dis-
played to ask if the playlist should be saved.

l Once the list is set up, the sequence can be run by clicking OK.
l The new playlist will be saved into the workspace window.

Figure 5.34 New playlist in the Workspace window

When the sequence is playing, the current SOP name is reported in the window bar of the
measurement manager:
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Figure 5.35 SOP name displayed

The measurement will run in a similar way to standard SOP measurements.

5.7.5 SOP Summary Report - EXTENDED FEATURE
The SOP Summary Report feature provides a simple means of quickly observing the SOP set-
tings that were used for an individual or multiple records in a measurement file.

1. In the records view, select the record(s) you want to review and then either right-click on
the record and choose View/Compare SOP settings, or click View SOP summary on the
Home ribbon.

2. Alternatively, from the SOP Editor, choose Summary Report. The SOP Summary report
window lists all settings applied by the SOP at the time of measurement. If more than one
record is selected from the records view, each record is shown in its own column.

3. To Save, Copy (to clipboard) or Print the information shown, click the appropriate option
from the SOP Summary Report window toolbar. The date that the SOP summary was cre-
ated is appended to all three options.

4. Select the following options from the SOP Summary Report window toolbar as required:
l Show all - this is the default view and shows all SOP settings from all items.
l Highlight differences - shows all items (as the default view), but highlights using dif-

ferent colors, areas where different values or SOP settings were applied.
l Show only differences - shows all items, but only those SOP settings where dif-

ferences exist.
l Compare to - becomes active when either Highlight Differences or Show only dif-

ferences is selected. This option then allows you select a 'source' item against
which to compare the others. Any field in another item that differs from the source
is highlighted or isolated (as selected).
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5. Select any required view options from the list as follows:
l DragDrop mode - ensures the columns are kept to a minimal size to enable the dis-

play of as much data as possible on the printed page, and allows elements to be
dragged and dropped easily into other applications such as Microsoft Word. If de-
selected the columns are only constrained to the width of the current window.

l Column headers in each section - adds each record name to each section's header.
l Move source column to the left - moves the column selected in the Compare to...

field to the leftmost position for easier analysis.

The following example shows how useful this tool can be to display the differences between
methods used for a selection of records:

Figure 5.36 Example SOP summary showing differences

5.7.6 SOP History - FEATURE KEY
Each time an SOP is edited and re-saved, its history is recorded for future audit purposes. The
SOP History feature exposes any differences between versions of the SOP.

This feature only applies to SOPs that have been revised and re-saved. If the Save As option is
used the SOP's history is not maintained.

1. Select View SOP History from the Home ribbon and then choose the
required file. The SOP Version History window is displayed. This lists all parameters as
applied by the SOP. Each version of the SOP is shown in its own column.

2. To Save, Copy (to clipboard) or Print the information shown, click the appropriate option
from the SOP Version History window toolbar. The date that the SOP history summary
was created is appended to all three options.
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3. Select the following options from the SOP Version History window toolbar as required:
l Show all - this is the default view and shows all SOP settings from all items.
l Highlight differences - shows all items (as the default view), but highlights using dif-

ferent colors, areas where different values or SOP settings were applied.
l Show only differences - shows all items, but only those SOP settings where dif-

ferences exist.
l Compare to - becomes active when either Highlight Differences or Show only dif-

ferences is selected. This option then allows you select a 'source' item against
which to compare the others - any field in another item that differs from the source
is highlighted or isolated (as selected).

5.7.7 Extract an SOP from a measurement file
It can be useful to extract the settings used to make a measurement into an SOP. This allows
the same settings to be easily applied in further measurements.

1. From the Record view, right click on the record(s) that you wish to extract the settings
from, and choose Extract SOP .

2. The SOP Editor is shown with all of the settings used at the time the measurement was
created. If more than one record was selected, multiple tabs are shown in the SOP Editor.

3. To save the extracted SOP choose File > Save from the SOP Editor menu . Altern-
atively, save the SOP as an SOP template by choosing File > Save as template. Refer to
section 5.7.1 for more information.

5.7.8 SOP Architect - FEATURE KEY
The SOP Architect guides you through a series of steps which are required for method devel-
opment. It performs multiple method development tests and analyzes the data to suggest a
suitable SOP.

Note: The process can take approximately 60 minutes to complete.

Click SOP Architect in the Measurements group of the Home ribbon.
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Figure 5.37 SOP Architect button

The Welcome screen displays general advice before you start:

Figure 5.38 SOP Architect Welcome

When you are ready to start, click Next.
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5.7.8.1 Sample and material details

Figure 5.39 Sample and material details

1. Enter the sample name.

2. Click Browse Database to select the material or enter the material properties.

3. Click Next.
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5.7.8.2 Sample test parameters

Figure 5.40 Sample test parameters

1. Specify the steps you want to do (Stability checks, Stir speed titration, Ultrasound titra-
tion, Laser obscuration titration).

2. Complete the Additional settings.

3. Click Next.
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5.7.8.3 Sample preparation

This displays advice about different types of sample.

Figure 5.41 Sample preparation

Click Next.

Conducting a beaker test

This includes advice about doing a beaker test.
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Figure 5.42 Conducting a beaker test

Click Next.
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Dispersant properties

Figure 5.43 Dispersant properties

1. Click Browse Database to select the dispersant or enter the dispersant properties.

2. Specify if you have added a surfactant and additive.

3. Click Next.
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Post-measurement clean sequence

Figure 5.44 Post-measurement clean sequence

1. Specify the clean settings.

2. Click Next.

5.7.8.4 Method development steps

The following method development steps are performed:

Step Description Actions
required

Estimated
time taken

Stability checks Examines any underlying stability issues with your
sample and dispersant. For example, if the sample is
agglomerating, dispersing or dissolving. Refer to sec-
tion 9.6 for further details.

Add sample
as required.

6 minutes

Stir speed titra-
tion

Identifies the stirrer speed that is most applicable to
your sample. Refer to section 9.8 for further details.

Add sample
as required.

12 minutes

Ultrasound titra-
tion

Identifies the duration of ultrasound required to dis-
perse your sample. Refer to section 9.7 for further
details.

Add sample
as required.

15 minutes
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Step Description Actions
required

Estimated
time taken

Obscuration
titration

Identifies the correct laser obscuration range for
your sample. Refer to section 9.4 for further details.

Add sample
as required.

10 minutes

Method repeat-
ability

Validates the method and confirms whether it can
be used as a Standard Operating Procedure (SOP).
Refer to section 9.10 for further details.

Add sample
as required

17 minutes

For each step:

1. Enter any required information and follow the on-screen prompts. As each step pro-
gresses, you will see an indication that measurements are being taken:

Figure 5.45 Measurement in progress

2. You will be prompted to add sample as required throughout the measurements:
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Figure 5.46 Add sample message

3. At the end of each step, you will see a summary of the results. Click the Next button to
continue to the next step.

5.7.8.5 Summary

The final step displays a summary of the confirmed settings for your sample.

Figure 5.47 Summary

Click Save & Close to close the SOP Architect and save the SOP.
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6.1 About the Record View
The Record view presents measurement files in a data grid that allows you to both view and
edit records.

Figure 6.1 Record view

Each open measurement file is given a tab in the Record view: click a tab to show all of the
records contained in that measurement file.

Note: You can open as many measurement files as required, and also combine results to
view all records within a single tab, making graphical data overlay possible.

A padlock icon indicates a read-only file that cannot be edited, such as Mastersizer 2000
files opened with the Mastersizer Xplorer software. You can also open files that were created
by Mastersizer 2000 instruments, but not edit them. Mastersizer measurement files consist of
a number of individual records. The record view also contains the Malvern Panalytical Portal.

6.2 Sort records - EXTENDED FEATURE
The data grid allows you to sort and filter measurement data. One measurement record is
shown per row which consists of a set of parameters, shown in columns. You can select which
parameters are displayed - refer to section 6.3.
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l Sort columns - click the column header to sort on that column and again to reverse the
sort order - sorting is either alphabetical, numeric or boolean, depending on the para-
meter selected.

6.3 Column configuration and parameter
selection - EXTENDED FEATURE
The Parameter Selection window allows you to define which parameters are shown in the
record data grid view.

Right click the top of the record view and choose Column Configuration to choose the para-
meters shown.
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Figure 6.2 Available and selected parameters

1. Select parameters in the Available list and then click the right-arrow button to trans-
fer them to the Selected list. Similarly, select items from the Selected list and click the
left-arrow button to transfer them to the Available list. To select multiple items, press
Ctrl and click. You can search for items by typing their first few characters into the
Search... field.

2. When all of the required parameters are shown in the Selected list, use the up/down
buttons to set the order that the columns appear in the data grid.

3. Click OK to apply the settings.

Tip: Another way to re-order the column headings is to drag and drop them (in the data
grid view) to the required position.
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6.4 Parameter filters - EXTENDED FEATURE
This section provides information on how to set up parameter filters within the record data grid
view.

To simplify the analysis of large numbers of records it is possible to set up parameter filters.
These can hide or make visible entire groups of records as required. It is possible to filter on
any recorded parameter, e.g. sample name, measurement date or a value range of a particular
measurement parameter.

1. Click the down arrow adjacent to one of the column headings. This shows all filterable val-
ues for the column, for example:

Figure 6.3 Parameter filter

2. Check any of the values to display only records with values that match the selected fil-
ters and click Apply filter.

You can set up as many filters as required in this way.
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6.5 Copy records
Records can be copied in the following ways:

l Duplicate records - To duplicate records to a new measurement file or within the same
measurement file. From the Clipboard group on the Home ribbon, select Copy - this will
copy the records to the clipboard. The content can then be pasted back into a meas-
urement file in the Mastersizer Xplorer software.

l Copy records into Excel - You can use the data export options to copy records into Excel
or similar applications - refer to section 7.8.

6.6 Create an average result
The Create average feature allows you to create a new "artificial" record which contains the
average values of all selected records.

1. From the Record view, select the records from which to create an average and choose
Create average from the ribbon. Alternatively, right-click a selection of records and then
choose Create Averaged Record.
The Create Averaged Result window is displayed:

2. Enter a Sample name and any Notes for the new result and then click the Create Average
button.

3. A new record is created within the current measurement file. To retain the newly created
record, save the measurement file.

Note: This feature is not available from the All Files view.

6.7 Merge records
This section provides information on how to use the All files feature of the Records view.

When working with multiple Mastersizer measurement files, it can be useful to compare data
by merging all of the files into a single (virtual) "measurement file" so that Mastersizer's power-
ful sorting, grouping and reporting features can be exploited.
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1. Open more than one measurement file. Refer to section 6.8 for more information.

2. Click the All files tab:

Figure 6.4 All files tab

The records contained in all of the open measurement files are shown combined into a single
file. It is now possible to sort, group, filter and report on the records displayed in this view. If
graphically analyzing multiple records in reports, each record's data is overlaid using a dif-
ferent color. Also refer to: section 7.3.

6.8 Work with measurement files
l To make a measurement it is necessary to open or create a measurement file.
l A measurement file can contain any number of individual records that have been made

over any period of time, using any dispersion unit type.
l Multiple measurement files can be opened and displayed in individual tabs.
l Compare data by merging files into a single list using the All files tab.
l Individual measurement records can be copied between files or copied into an empty

measurement file.

6.8.1 Open existing measurement files
The Mastersizer Xplorer software can open both measurement files made on the Mastersizer
3000 variants (.mmes files) and Masterziser 2000 (.mea files). Mastersizer S/X/Mi-
cro/Microplus instrument files (.sam files) can also be opened. Files from the Mastersizer
Micro/Microplus first have to be saved to a Mastersizer 3000 measurement file format. No re-
analysis is possible for .sam files.

Note: Mastersizer 2000 files can be opened for read-only analysis. They are shown with a dif-
ferently colored file icon and also a lock icon .
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Mastersizer 2000 files can only be edited if they are first saved in Mastersizer 3000 format,
using Save > As, or by copying and pasting the results into a Mastersizer 3000 file.

1. To open a Mastersizer 3000 measurement file: From the Home ribbon click Open > Meas-
urement file.

2. To open a Mastersizer 2000 measurement file: From the Home ribbon click Open >
Legacy Measurement File.

3. Scroll the open measurement file tabs left and right using the scroll buttons.

Figure 6.5 Scroll Measurement tabs

4. Use the button for quick selection of any open measurement file.

5. To close a measurement file: Click the in the right corner of the tab of the meas-
urement file you wish to close.

Tip: To view more information about an open measurement file, move the mouse pointer
over its tab - information about the file type, access mode and location are provided.

6.8.2 Create and save measurement files

1. Click New > Measurement file from the Home ribbon.

2. Click Save > Save as... from the Home ribbon and then enter a new file name.

3. Alternatively, choose Save from the Home ribbon if the file has already been saved and
you wish to just overwrite the last saved instance.

4. If multiple measurement files are simultaneously open, click Save > Save all to save the
changes to all modified files.

6.9 Edit records
This section provides help on the Edit Result feature of the Records view.
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Each Mastersizer record is the result of the processing of raw measurement data. By editing a
record it is possible to re-apply new values to some of the parameters used in the original
measurement settings in order to generate a completely new record.

This can be used to explore the effect of using different settings from those chosen when the
measurement was made. Typically, adjustments are made to improve the ‘fit’ of the calculated
result to the data. Use the SOP summary report to show which parameters have been altered.

1. From the Record view, right click on a record, or group of records, and choose Edit Res-
ult...

2. The Result Editor window is displayed.

Figure 6.6 The Result Editor window
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3. This contains all of the information set up in the original manual measurement. Some of
the options are unavailable because they relate only to the physical set up of the original
measurement, for example, all of the Measurement Duration options.

4. Edit any available sections of the Result Editor as required. Any edited information is
clearly highlighted by a different background color.

Figure 6.7 Edited information in the Results Editor

5. Click OK when all settings have been altered to your specification. The newly-set values
are now re-applied to the existing raw measurement data. A brief message is displayed
whilst this happens.

Figure 6.8 Edited result generated

When the result has been edited, the edited result is then displayed as the last item in the
record view (this is dependent upon the view configuration).

Note: If you save the measurement file, the new settings will overwrite the original file set-
tings. To create a result-edited version of a file and still retain the original settings, first
copy the file (using Windows) and then edit the copy.
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6.10 Measurement Record Search Feature
The measurement record Search feature allows you to search for all measurement files that
have a filename matching a specified search term and import those records into the record
view.

Figure 6.9 The search feature in the Home tab

Click the Search button to open the Search measurement records window:

Figure 6.10 The Search measurement records window

The Search measurement records window contains several controls enabling you to specify:

l The search term to use
l The search location (or primary folder)
l Sub-folder searching
l Selecting a previous record search
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6.10.1 Search terms
The search term supplied will be used to match against file names.

If a measurement file filename contains the search term supplied then the records will be
extracted and added to the search results, otherwise the measurement file will be ignored.

Wildcard search terms can be used:

l (*) will match zero or more characters.
"abc*123" will match "abc123", "abc 123", "abcd123" and "abczzzzzzzzz123".

l (?) will match zero or one characters.
"abc?123" will match "abc123", "abc 123", "abcd123" but not "abczzzzzzzzz123".

The Search location specifies the primary folder from which to begin searching for meas-
urement files. Only the specified folder is searched.

6.10.2 Sub-folder Search
Checking the Search sub-folders checkbox will expand the search to include files stored in the
primary folder, specified in the search location.

Note: The larger the primary folder the longer the search time.

6.10.3 Previous Searches
Each search requested will be saved for the current user, and can be located from the Pre-
vious searches dropdown.

Up to 12 searches will be stored - the oldest search is removed first after 13 searches.

Chapter 6 Record view



143

6.10.4 Search

1. Click the Search button to initiate a search. The window will indicate that a search is
being performed:

Figure 6.11 Finding measurement files

2. After all measurement files have been found, each file is processed sequentially to
extract the measurement record information. A new search tab will be opened in the
record view, showing the current search:

Figure 6.12 Search tab in the Record view

3. By default, the first column available in the record view is the filepath. Initially the search
will show all records found and where they are held.

Note: To avoid extremely large measurement files, search results cannot be saved, but
records from a search tab can be copied into a new measurement file. It is recom-
mended only to do this with a few records.

6.10.5 Stop Searches
To stop a search, press the Stop button. The search will stop finding or processing files
(depending on when Stop was pressed).

Any Partial search results will still be returned in the opened search tab as the search may still
have found and processed files at this point.
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6.11 Optical property optimizer
This section provides help on the Optical Property Optimizer feature. This feature enables you
to visualize quickly the effects of changing the optical properties on the result, without gen-
erating multiple new records. This provides an efficient way of assessing the fit and results in
order to optimize the optical properties used for the sample.

Figure 6.13 The Optical property optimizer

The result of a Mastersizer measurement, or record, is calculated by applying an optical model
to the measured scattering data. When using Mie theory (recommended by ISO 13320 for
samples smaller than 50 μm in size), the optical model requires you to enter the optical prop-
erties of the sample material and dispersant. The optimizer allows you to apply different values
for the optical properties and assess the fit and results without generating multiple new
records.

The fit can be assessed using the data graph which shows both the scattering data from the
measurement, and the scattering data calculated by the optical model (using the selected
optical properties). How closely these two sets of data agree can be used to assess the appro-
priateness of the optical properties.

Residual values are provided as a numerical value to represent the closeness of the fit. The
residuals are calculated from the area between the measured and calculated scattering
graphs. In general, a lower residual indicates a better fit. However, the effect on the result
should always be considered when optimizing the fit.

When using the Optical Property Optimizer, the data graph showing the fit, the residuals and
the result are used to select the most appropriate optical properties for the sample.

Refer to section 9.2 and section 9.3 for more information on fit and the optical properties used
in the measurement.
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6.11.1 How to use the Optical property optimizer
From the Records view, select the records required. Then from the Home ribbon bar, click
Optical property optimizer from the Result group.

The optimizer can be used with multiple records, for example to assess the effect of optical
properties on different size grades of the same material. To give the best results, you should
select records of the same material measured under similar conditions.

Note: Multiple records must also have been taken using the same Mastersizer variant.

The Optical property optimizer will open showing the results of the selected records.

Figure 6.14 Optical Property Optimizer
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The window is made up of the following areas:

l Records
l Result graph
l Data graph
l Trend table
l Optical and analysis settings

6.11.1.1 Records

This shows the records chosen from the Records view, including the record number and
sample name.

The check boxes can be used to choose which records to display in the Result and Data graph
views.

6.11.1.2 Result graph

Each record that is selected is shown on the graph using a different color, as indicated on the
legend. The type of graph shown is modifiable by you and includes a Histogram and Fre-
quency curve, as well as Over/Undersize curves. The default view is frequency.

l Right click on the graph and select properties to alter the graph. (Also refer to: section
7.4.4.)

6.11.1.3 Data graph

The Data graph shows the light energy received by each detector, and the light energy cal-
culated by the analysis. The default view is Data and fit (weighted).

l Right click on the graph and select properties to alter the graph. (Also refer to: section
7.4.4.)

6.11.1.4 Trend table

The trend table shows displays the trend parameters selected for each record that is in the
Record View.

By default, the system includes Dv10, Dv50, Dv90, Weighted Residual and Residual, in the
trend table. To alter the selection:
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1. Right click on the table and select properties.

2. In the Properties window add or select a new data item against which to display.

3. Click the button to open the Report Parameter Selection window and select the
required parameters.

6.11.1.5 Optical and analysis settings

Optimization graph/plot

The Optical and analysis settings area is used for adjusting the optical properties - Refractive
Index (RI) and Absorption Index (AI).

The graph displays the following information:

l The AI is shown along the Y axis - to emphasize the absorption, the graph shading is
graduated as the absorption increases. The blacker the graph the higher the absorption
and, the lighter the graph the lower the absorption.

l The RI is shown along the X axis.

The original RI and AI values are shown in an active properties label, with the position marked
by a dot (the dot also acts as a drag point).

Figure 6.15 Original Refractive Index (RI) and Absorption Index (AI) values label

When you change the RI and AI values, the result and data graphs will update accordingly.
Continue changing the values to get the best residuals, the best fit and assess the effect on
the results.

There are several ways to change the values:

l Click the dot at the front of the properties label and drag the label around the graph.
l Click on the properties label and use the cursor keys to move it.
l Click on the properties label and then click a position elsewhere in the graph - the label
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will then move to that position.
l Type in the RI and AI values on the properties label and press the Tab key - the label will

then move to that RI or AI position.

A zoom function for the selection area is available by pressing control and selecting the
required area.

If the Different Blue-light optical properties check box is selected the Blue light optical active
properties label will be displayed.

Figure 6.16 Blue light optical active properties label

The Blue light properties can then be adjusted.

Clicking the Original setting row in the Optical property sets table will reset the RI and AI values
and place the active label, values and graphs back to the original record/results.

Additionally, the particle shape/type and analysis models can be altered to view the effect of
the measurement result.

Figure 6.17 Altering particle shape/type and analysis models

Refer to the following advice topics for more information on the analysis settings used in the
measurement:
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l Data Processing in section 10.5.1
l Particle Type in section 10.2.2

Optical property sets

When a result has been satisfactorily edited the optical properties used can be saved by click-
ing the button. This will then display the new properties as an Optical property set in
the table.

The Set name and Notes columns can be edited to identify the property set and input any addi-
tional information:

Figure 6.18 Optical Property Sets

With the set stored, the settings and properties can then be saved into the Materials database
by selecting the property set and then the Save button.

Additionally, the new properties can be applied directly to the original selected records, gen-
erating new records with the new optical properties. Select the property set and then the
Apply button, new records are then generated and added to the records view. Refer to the fol-
lowing topics for more information:

l The Materials Database in section 5.4
l Editing records in section 6.9

To remove any property set, highlight the unwanted set(s) and press Remove. Alternatively
press Remove All to remove all sets except the Original settings.
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Note: The table contents are automatically stored on exit from the optimizer, and can only be
deleted manually. Make sure that the table list is maintained regularly.

6.12 Analysis report
The Analysis report provides a useful breakdown of the measurement data.

Figure 6.19 Analysis report window
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To display this report, select the record(s) to analyze in the Record view and then click the Ana-
lysis report from within the Reports tab.

The following information is displayed in the report:

1. Weighted Residual - an indication of how well the calculated data was fitted to the meas-
urement data. A good fit is indicated by a residual of under 1%. A residual of over 1% may
indicate use of incorrect RI and AI values for the sample and dispersant.

2. The statistics of the distribution are calculated from the results using the derived dia-
meters D[m,n] – an internationally agreed method of defining the mean and other
moments of particle size. Refer to British standard BS2955:1993 for more details.

Dv 50, Dv 10 and Dv 90 are standard percentile readings from the analysis.

l Dv 50 - the size in microns at which 50% of the sample is smaller and 50% is larger. This
value is also known as the Mass Median Diameter (MMD) or the median of the volume dis-
tribution. The v in the expression Dv 50 shows that this refers to the volume distribution.
This can be replaced by s for surface, l for length or n for number distributions.

l Dv 10 - the size of particle below which 10% of the sample lies.
l Dv 90 - the size of particle below which 90% of the sample lies.

3. D[4,3] - the Volume Weighted Mean or Mass Moment Mean Diameter, also known as the
De Broucker mean.

4. D[3,2] - the Surface Weighted Mean, also known as the Surface Area Moment Mean Dia-
meter or Sauter mean.

5. Span - the measurement of the width of the distribution. The narrower the distribution,
the smaller the span becomes. The span is calculated as:
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The x is replaced by any of the letters v, s, l or n that define the distribution type.

6. Concentration - the volume concentration. This is calculated using Beer-Lambert’s law.
For full details see the following section.

7. Obscuration - this helps you set the concentration of the sample when it is added to the
dispersant. It is a measure of the amount of laser light lost due to the introduction of the
sample into the analyzer beam.

The obscuration term can be expressed mathematically:

Ls is the light intensity measured in the central detector when a sample is present in the cell,
Lb is the same but with clean dispersant (i.e. with no sample), from the background meas-
urement. Obscuration is usually expressed as a percentage: 100 x Ob.

An ideal range is between 3 and 20%, depending on the sample and dispersion unit used.

8. Distribution - shows the type of distribution the analysis has used. Options include
volume, surface area, length or number. Remember that the Mastersizer measurement is
fundamentally a measurement of the volume distribution - transforming the result into a
surface, length or number distribution is a mathematical process that may amplify any
error in the original result, especially at the fine end of the size distribution.

9. Uniformity - a measure of the absolute deviation from the median.

Here d(x,0.5) is the median size of the distribution (where x is replaced by v, s, l or n) and di
and xi are respectively the mean diameter of, and result in, size class i.

10. Specific Surface Area (SSA) – the total area of the particles divided by the total weight.
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Vi is the relative volume in class i with mean class diameter of di and p is the particle density.

If the SSA is used, it is important that the density of the material is defined (in the SOP’s Mater-
ial settings). This figure is a mathematical calculation based on the assumption that the
particles are both spherical and non-porous.
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7.1 About reports
Reports help to make sense of all the data that is generated in a Mastersizer measurement.
They enable you to graphically analyze measurement data and also isolate areas that are of
interest using tables and graphs.

Mastersizer's reports consist of information sections (widgets) that are displayed together in a
single report for easy on-screen analysis or printing. Reports can be configured so that only
those items that are of interest to you are displayed. It is also possible to alter the order in
which the sections within the report are displayed.

Additionally, data in the reports can be directly copied and exported to other Windows applic-
ations.

7.1.1 View reports
This section describes how to view and manipulate reports about the records contained within
measurement files. It is assumed that a measurement file is open and that it contains several
records.

1. Select a record or number of records from the Record view.

2. If it is not already shown in the current view, select the Reports tab. One of the reports for
the current workspace is then shown (by default this is the Analysis report).

Tip: It can be easier to work in 2-pane vertical split view whilst initially selecting the
records. Any selections or de-selections of records are then updated immediately in
the visible report.

7.1.1.1 Collapse/expand graph sections

To collapse and expand the legend in a graph sections, click the up or down arrows at
the bottom left of the graph legend.

Scroll layout

Reports are presented in sections that are stacked vertically. To reveal all of the information on
the report requires the use of the scroll bar, or collapse individual sections as required.

7.1.1.2 Copy data

Refer to section 7.6.
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7.2 Malvern Panalytical reports
In addition to the ability for users to build reports tailored to their own requirements, Malvern
Panalytical supplies a number of standard reports with the software. The standard reports can-
not be edited or deleted. Example reports include:

l Analysis - a report that provides a mixture of key parameter sections and a particle size
distribution graph.

l Data - this report mainly focuses on the raw light scattering data gathered by the instru-
ment during the measurement. It includes a light scattering graph.

l Fit - shows the scattered light data together with a curve calculated from the result dis-
tribution. Differences between these two curves come from deviations in the calculated
result from the actual result and may be due to measurement errors or poor choice of
optical properties and calculation model.

l Result overlay - compares the selected results and includes a table which contains the
RSD for assessing the stability of the selected results.

l Trend - plots the percentiles against record number. This enables trends in the results to
be assessed, for example during sample dispersion.

Note: Although the standard reports cannot be modified directly, they can be opened for
editing and saved under a different report name to create a new report.

7.2.1 Customize the Report tab
To choose which reports are displayed on the Reports tab:
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1. Click on Report selector in the Reports section of the Home ribbon:

Figure 7.1 Report selector

The Report selection window is displayed:

Figure 7.2 Report Selection window

2. Select reports in the Available Reportss list and then click the right-arrow button to
transfer them to the Selected list. Similarly, select items from the Selected Reports list
and click the left-arrow button to transfer them to the Available list.
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3. When all of the required reports are shown in the Selected Reports list, use the up/down
buttons to set the order that the reports appear on the Reports tab.

4. Click OK to apply the settings.

7.3 Select records to display in a report
This topic provides information on how to select records in the Record view so that they can
be reported on.

Mastersizer reports include data from all measurement records that are currently selected in
the Record view. Records can also be sourced from different measurement files and still com-
pared in the same report - refer to section 6.7 for more information.

l To view a report of all the data contained in a single record: Click on the record within the
list of records. The display will reflect the selection assuming you are in a view displaying
records and reports simultaneously.

l To view a report of all the data contained within multiple records: Use Shift and click to
select contiguous records, or Ctrl and click for non contiguous records. When multiple
records are selected, each record is represented by a different color within the report.

7.4 Create and edit reports
In addition to the standard reports shipped with the system, the Mastersizer provides a quick
and simple way to define and modify reports to your own specification. This section gives
information on how to define and modify reports. Any reports that you create are indicated
with the user added icon and can be modified or deleted.

7.4.1 To create a new report
To create a new report click New > Report.

A blank report will appear showing a Header and Footer fields and a widget selector.
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Figure 7.3 Blank report containing header and footer fields, and a widget selector

Note: The Header and Footer fields will only be visible in the printed report.

7.4.1.1 Header

You can edit the header as required to include the Report Name, Company name, and Com-
pany logo or other image.

Figure 7.4 Example header

7.4.1.2 Footer

The footer contains Malvern Panalytical information, Report creation and printed date, and the
Mastersizer Xplorer software version. The footer cannot be altered.
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7.4.1.3 Widgets and containers

Widgets are used to populate the report with the information required. Each widget used sits
within a container.

Containers can be chosen to format and layout the report as desired. Roll over each container
for a description.

Figure 7.5 Widget containers

1. Click to select a container. Blank widgets will appear as blue squares.

Figure 7.6 Blank widgets in a container

2. Click in the blue square and select a widget from the selection pane.
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Figure 7.7 Select a widget

3. Roll over each widget to show descriptions of all the choices. Choices include: Meas-
urement data and information graphs and tables, text and picture boxes, calculation
editor, etc.

The image below shows a Result table and Result graph once inserted into the container.

Figure 7.8 Results table and graph inserted in container
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Options

Table 7.1 Report options

Item Specification

Select to configure the properties for each widget. Refer to section 7.4.3.

To select a different widget for the container.

Each container can be resized vertically.

Any unwanted container can be deleted.

Choose a different layout for the widget report items within this container.

7.4.2 Edit an existing report
To edit an existing report, first select the report from the Reports tab and then choose Edit this
report from the Reports menu.

Figure 7.9 Edit a report
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The report is now displayed in edit mode. Alter the report in the same way as creating a new
report.

7.4.3 Configure a widget’s properties
Each widgets properties can be configured by selecting the Edit properties icon. All wid-
gets have a Title field. Use the default name or enter another to identify the widget.

Table 7.2 Editing widgets

Property How to edit

Picture box 1. Select the alignment position - left, right, center or stretch, and the picture
size scaling factor

2. Click on the center of the box to open the Windows Explorer and select the
required image.

Data table Displays the measured data parameters - there are no editable parameters.

Signature Displays the signature history for any of the records selected.

Fit and Result tables Select the Display options as required.

Data, Result and
Trend graphs

Result graphs show the particle size distribution. Refer to section 7.4.4 for details
on viewing and editing.

l The Data graph shows the light energy received by each detector.

l Result graphs are an optional reports element that shows the particle size dis-
tribution for all of the currently selected records.

l Similar to the trend plot shown in Manual Measurements, the reporting trend
chart shows a graphical plot for each record from a measurement that is cur-
rently selected in the Record View.
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Property How to edit

Text / Table output
calculation

The edit properties icon will display the Custom calculation properties editor.
Construct the calculations as required.

Figure 7.10 Custom calculation properties editor.

Text box Enter basic text and comments about the report, measurement or other asso-
ciated information.

Parameter 1. Click the button, and select the parameter from the Report parameter
selection window. Only one parameter can be selected at a time.

2. When all parameters are selected. Configure the list order with the
arrows.

3. Clicking icon will enable the color and font style of the parameter to be
changed.

Figure 7.11 Changing color and font style.

l Remove a parameter with the icon.
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7.4.4 Graphs in reports
The types of graph available include:

l Data - shows the light energy received by each detector.
l Result - an optional reports element that shows the particle size distribution for all of the

currently selected records.
l Trend - a graphical plot for each record from a measurement that is currently selected in

the Record view.

Whenever a graph is displayed, click on the plot lines to display data points. Move the mouse
pointer over the data lines to see numerical information relating to that data point.

Figure 7.12 Data points shown on graph plot lines

Select the Edit properties icon to change the graph properties - this opens the graph prop-
erties window. Refer to section 7.4.5.
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Note: When in presentation mode, a graphs properties can also be changed by selecting the
Edit properties icon. This will only alter the graph view being displayed, but not
alter the saved report. Select Edit this report to alter permanently.

7.4.5 Edit graphs in reports
The options available when editing graphs depend on the type of graph.

7.4.5.1 Edit a data graph

The Data graph shows the light energy received by each detector.

Figure 7.13 Data graph properties

Chapter 7 Reports and export



168

Display options

From the Display Options panel, select the type of graph to be displayed whenever a record is
selected.

l Data - distribution of scattered light from the particles withe the background removed.
l Background - distribution of background scattered light from the optics and dispersant.

This measurement is made before the sample is added for a wet measurement or before
the feeder is activated for a dry measurement.

l Fit - the scattered light data together with a curve calculated from the result distribution.
Differences between these two curves come from deviations in the calculated result
from the actual result and may be due to measurement errors or poor choice of optical
properties and calculation model.

l Data and Fit (Weighted) - the data and fit curves weighted by factors used in the result
calculation

l Data (Normalized) - the scattering data curves for the selected measurement records
but normalizes the data so they appear to be made at the same obscuration.

Plot as

Select the type of graph that should be used - either a Histogram or Curve.

Additional Options

Finally, select whether to show grid lines and whether to hide negative data or excluded
detectors.

7.4.5.2 Edit a result graph

Result graphs are an optional reports element that show the particle size distribution for all of
the currently selected records.

Each record that is selected is shown on the graph using a different color, as indicated on the
legend.
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Figure 7.14 Result graph properties

Display options

Select the type of graph to be displayed whenever a record is selected.

l Histogram - a histogram of the proportion of the result between two sizes. The size
boundaries of the histogram bins are set from the Edit-User sizes dialogue box.

l Frequency - a continuous curve showing the probability of finding a particle of a spe-
cified size. The curve is normalized to show the proportion of result between two sizes.
Move the mouse pointer over the curve to display the two sizes.

l Oversize - the result as a cumulative curve of the proportion of the result larger than a
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specified size.
l Undersize - the result as a cumulative curve of the proportion of the result smaller than a

specified size.

You can select the Average Result option, to calculate an average for a collection of
records.

Figure 7.15 Example of individual records

The individual records shown would then be combined to give an average result:

Figure 7.16 Average result
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Frequency type

Choose to show frequency curves calculated to be compatible to older Mastersizer instru-
ments or as defined by the ISO 9276-1 standard.

Size Axis Type

Choose between logarithmic or linear size scale with size (particle diameter) in microns.

Alternatively, choose to display the size axis in Phi units rather than microns.

Result Axis type

Choose between a linear result scale, Rosin-Rammler plot or Cumulative probability dis-
tribution.

The Rosin Rammler and Probability plots are only appropriate for cumulative oversize or under-
size graph types.

Adaptive Diffraction

For an adaptive diffraction record, choose to display Steady State or Transient State or both.

l Steady State - displays the steady state result with a solid line.
l Transient State - displays the transient state with a dotted line.

7.4.5.3 Edit a trend graph

Similar to the trend plot shown in Manual Measurements, the reporting trend chart shows a
graphical plot for each record from a measurement that is currently selected in the Record
view.

By default trend graphs plot Dv10, Dv50, Dv90 data against record number. Each parameter is
given a different color.

Y Axes

The data currently plotted is shown in the top panel of the window.
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Figure 7.17 Trend graph properties - Y axes

1. To remove the currently plotted data, click next to the parameter description.
To add or select a new data item against which to plot, click the button. A new ele-
ment is added into the top panel.

2. Select the new element to display its properties in the lower panel.

3. Click the button to add a parameter from the Parameter Selection win-
dow.

Figure 7.18 Parameter selection window
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4. Select the required parameters and press Ok to confirm selection.

Note: Parameters with numeric values (such as percentiles) are editable and indicated with
. To edit the parameter numeric value, click the parameter and amend the value.

Any value entered that is inappropriate for the parameter is flagged with an exclam-
ation mark icon - amend the value accordingly if this is the case. It is possible to enter
multiple variants of the same parameter with different associated values (for example
Dv10, Dv50 and Dv90). These are then indicated on the graph with different colors.

5. Select the position in which the axis should be labelled - left or right.

6. Select a scale type - Linear or Logarithmic.

7. Click OK when you have completed the settings.

X Axis

The X axis parameter (Record Number) is shown in the top panel:

Figure 7.19 Trend graph properties - X axis

You can change the parameter shown on the X axis by clicking on Record Number.
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7.4.6 Finish and save the report
Once all widget and container elements are configured and aligned as required, select

to finish editing. Then choose whether to save over the altered report or save as a
new report.

7.5 Select reports to display in a workspace
The set of reports that are displayed are associated and saved with the workspace that is cur-
rently selected. Refer to section 2.6. This section gives information on how to choose the set
of reports that are shown in the current workspace and how to arrange the order of the report
tabs shown.

To choose which reports are displayed on the Reports tab:
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1. Click on Report selector in the Reports section of the Home ribbon:

Figure 7.20 Report selector

The Report selection window is displayed:

Figure 7.21 Report Selection window

2. Select reports in the Available Reports list and then click the right-arrow button to
transfer them to the Selected list. Similarly, select items from the Selected Reports list
and click the left-arrow button to transfer them to the Available list.
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3. When all of the required reports are shown in the Selected Reports list, use the up/down
buttons to set the order that the reports appear on the Reports tab.

4. Click OK to apply the settings.

7.6 Copy data from reports
Report widgets and data can be copied directly from the reports and quickly exported to other
Windows applications.

There are two ways to do this: click on the export content icon on the report widget and
either select Copy as image or Copy raw data.

Figure 7.22 Copy report widgets and data

7.6.1 Copy raw data
This will enable the following data to be copied to the clipboard, which can then be pasted into
the secondary application:

l Size distribution graphs - copies the complete size distribution data set, including data
for all results which are over-plotted on the graph.

l Result tables - copies all of the size distribution data from the table.
l Parameter grids - copies all values for the parameters listed in the selected grid, includ-
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ing measurement details, analysis settings and results.
l Data and fit graphs - copies a data set reporting the measured signal per detector.
l Trend tables - copies all of the table data.

The copied widget information will be exported as text, for example:

Result

Concentration 0.0032 %

Span 0.282

Uniformity 0.083

Specific Surface Area 56100 m²/kg

D [3,2] 0.102 µm

D [4,3] 0.103 µm

Dx (10) 0.0893 µm

Dx (50) 0.103 µm

Dx (90) 0.118 µm

7.6.2 Copy as image
Copies an image of the report widget: either plot or data.

Figure 7.23 Image of a report widget

Note: An alternative way to export data to other Windows applications is to use the Export-
ing data function.
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7.7 Print reports
This topic provides information on how to create a hard-copy printout from on-screen reports.
Printing options are available from the Print option on the Home ribbon.

7.7.1 Print preview
To check how a report will appear before it is printed, click Print > Report Print Preview from
the Home ribbon. A preview of the currently selected report is displayed:

Figure 7.24 Print preview

The following display options are available:

l Zoom - zoom in and out of the print preview. When zoomed in it may be necessary to use
the scroll bars to see all widgets on the report.

l 100% - shows the report at 100% zoom.
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l Page width - stretches the page to view the width of the page within the current window.
l Whole page - zooms out to show an entire report page in the window.
l Two pages - zooms out to show two pages of the report side by side.

Note: These options do not have any impact on the final report printout.

7.7.2 Print
To print the report, click the Print icon:

Figure 7.25 Print icon

7.7.3 Print in batches
Batch printing allows you to print a set of different report types quickly with one click, instead
of selecting and printing each report type individually.
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1. On the Home ribbon, select Print > Batch print reports from the Documents group.

Figure 7.26 Batch printing

2. Select reports in the Available list and then click the right-arrow button to transfer
them to the Selected list. Similarly, select items from the Selected list and click the left-
arrow button to transfer them to the Available list. To select multiple items, press Ctrl
and click.

3. When all of the required reports are added to the Selected list, use the up/down
buttons to set the order that the reports will be printed.

4. Click OK when finished.

5. In the standard print dialog box, select which printer to use and click OK.

Note: To delete a user-added report, select the report in the Available list and click the
button.
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7.8 Export data
This topic describes how to export record data for analysis in third party applications.

Data recorded by the system can be exported for analysis in other software applications, for
example Microsoft Excel.

It is possible to export either selected records or all records contained in a single meas-
urement. Additionally, by selecting the All Files tab when multiple measurement files are open,
a selection of, or all records from, multiple measurement files can be exported. The ability to
create export templates further enhances the flexibility of the system, this allows you to select
only those parameters required for your analysis, as well as providing control over other data
formatting options.

Note: An alternative way to export data is to use the Copy data / Copy raw data functions to
directly copy data from section 7.6.

7.8.1 Export records
To export records:

1. Select the records whose data you wish to export.

2. Right-click and select Export Selected Records... (or select Export All Records... to export
all records).
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Figure 7.27 Export data

The Export Data window shows a preview of the data to be exported as specified by the cur-
rently selected export template.

3. Select an appropriate export template from the drop-down list - the preview panel is
updated accordingly.

4. Change the presentation of the data using the Ordering, Delimiter, Formatting and
Header options (refer to section 7.8.2 for more information).

5. Click Export to file... to save the data as a separate (.txt or .csv) file, or select Export to
clipboard to copy the data to the clipboard.

Tip: You can drag and drop record data from the Record view straight into Microsoft
Excel/Word. The parameter values copied are all of those currently shown in the
records view.
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7.8.2 Export templates
Export templates allow you to store and quickly access, commonly-used data presentations
whenever data is to be exported.

You can build and store any number of export templates. Each template is associated only
with the workspace in which it was constructed.

7.8.2.1 Create or modify an export template

1. To create a new export template, click New > Export template (or click Add from the
Export Data window). To modify an existing template, select it from the drop-down in the
Export Data window and click Modify.

Figure 7.28 Export template
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2. Enter a name and short description for the template.

3. Select the type of template.

You can create two types of export templates:

l Standard: Malvern Panalytical standard export template settings.
l SPC: Statistical Process Control (SPC) export template settings.

Standard Export template

For a standard export template, the list of parameters is based on the current column con-
figuration in the Record view.

1. Click Change selection and order to display the Parameter selection window.

2. Select the required parameters.

3. Choose either rows or columns from the Ordering selector to present the data hori-
zontally accordingly.

Figure 7.29 Ordering selector

4. From the Delimiter selection, choose either Comma separated (csv) or Tab separated.
Your choice will depend on the requirements of the target application.

Figure 7.30 Delimiter selector
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5. Use the Formatting option to select either Format values as displayed in software, which
displays numeric information to a limited number of decimal places (this may be prefer-
able for presentation purposes), or Unformatted values to show all data as recorded by
the system.

Figure 7.31 Formatting selector

6. Select Header on/off to specify whether the export should contain the names of the
fields as a header row (or column).

Figure 7.32 Header selector

7. Click Save when complete.

SPC template

The additional parameters for the SPC template are described below:
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Figure 7.33 SPC template

l Header parameters - these can be used to indicate run-specific, or traceability-specific,
data. The Parameters selection is the same as the Standard export template. A prefix can
be added to exported data.

l Data parameters - select these parameters as done in the standard export template. In
addition to adding a prefix to the exported data, you can also add a measurement Index
tag.

l The Formatting option lets you set the exported data to be formatted as in the software
or unformatted.

7.8.2.2 Delete an export template

From the Export Data window, select the template you wish to remove and click Remove. The
Mastersizer Xplorer software asks for confirmation of the action before permanently removing
the template.
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Note: You can't delete or modify the Default template.
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8.1 Software licensing
Note: Mastersizer 3000E Basic and Mastersizer 3000+ Lab users are restricted to use of the

software only on the computer that is attached to the Mastersizer. Licenses cannot be
shared. If multi-workstation use is required, upgrading to the extended software is
required.

A Data Quality Guidance license is also restricted to use on the computer where it was
installed and cannot be copied to another computer.

Without a valid license, the Mastersizer software will not function. The software automatically
generates a license on the PC that is connected to the instrument.

l After first installation of the software you will be prompted to accept this license - click
Accept license to accept the license file.

Figure 8.1 Accept license window

Note: If the software was set up by your administrator or Malvern Panalytical, you may not
see this window. This means that the software is already activated.

8.1.1 Share a license file
You can share a Mastersizer software license so that other PCs can use the software without
having an instrument connected. This could be useful if you wanted to undertake analyzes on
measurement files whilst away from instrument.
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Note: The license file contains the identification of the user and the instrument from which it
was generated. Do not share the license outside of your authorized user group.

1. Click File > About to view the software information page.

2. Click View license... to display details of the active license:

Figure 8.2 Active license details

3. To export the license, click Share this license... - the software provides details about
what is included in the license:

Figure 8.3 Share license
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4. Click Yes and then specify a file name and location in which to save the license. Send a
copy of this .license file to the Mastersizer software user without a license. On the first
attempt to run the software, you will be prompted with an install license message.

5. Click Install license and then browse to the location of the .license file.

6. The credentials of the license file are then displayed - click Install license.
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9.1 Fundamental concepts
To understand the meaning of the results from the Mastersizer, a number of fundamental con-
cepts require explanation. These are:

l How the concentration is calculated
l The results are volume-based
l The result is expressed in terms of equivalent spheres
l How the distribution parameters are derived

9.1.1 Calculate the Concentration (Cv)

9.1.1.1 Beer-Lambert law

The software uses the Beer-Lambert law to calculate the concentration of the sample. This
may be expressed as:

Where:

l I is the intensity of light at a distance b in the particle field of absorbance α.
l I0 is the intensity of the light beam as it enters the particle field.
l I / I0 is the relative transmission (T) of the beam (measured directly by the instrument). I0

is the intensity of the laser beam measured at the receiver when no sample is present
and I is the intensity with sample in the beam.

Expressing the Beer-Lambert law in terms of relative transmission and re-arranging gives the
following expression for the absorbance:

(1)
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9.1.2 Volume concentration
The term α contains information about the concentration and size of the particles. From scat-
tering theory the light attenuated by a particle i (ai) may be described in terms of the cross-
sectional area of a particle:

Where:

l ri is the radius of the particle i , with cross-section πr2i
l Qi is the efficiency of light extinction (by scattering and absorption), calculated from Mie

theory for a particle of radius ri.
l ni is the number of particles of radius ri.

In terms of the volume of particles , the equation above becomes, for an
ensemble of particles:

If the size of the particles is expressed in terms of the diameter di= 2ri and the volume terms
can be separated into a relative volume distribution v and a total concentration Cv (total
volume of particles in a unit volume of dispersant) the equation then becomes:

Substituting the above into equation (1) and rearranging to make concentration the subject
gives:
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If d is measured in μm and b in mm, and v is the relative concentration of the size distribution
(such that ) then:

This equation provides the concentration in parts per million (ppm). To calculate the value as a
percentage volume concentration, the final value is divided by 10,000.

In the above equation:

l The Transmission (T) is a value between 0 and 1 which is measured directly by the instru-
ment.

l The particle size distribution vi is the relative volume in size-class iwith mean diameter di.
l Qi - the mean extinction term for size-class i - is calculated from scattering theory and is

a function of the optical properties of the particle and dispersant media.

9.1.2.1 Concentration at different obscurations

This advice gives an approximate idea of the obscuration ranges to use during a meas-
urement.

It is possible to convert the obscuration limits into an equivalent volume concentration but
there is a strong size dependence that makes it difficult to use the data at the time of meas-
urement. The relative volume concentrations of monomodal (single sized) particles that would
give a certain obscuration is illustrated below. The actual curves may differ. It will be clear that
there is a size dependence - an obscuration of 30% means a widely varying volume con-
centration dependent on size.
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Figure 9.1 Relative volume concentrations of monomodal (single sized) particles that would give a certain
obscuration

In the more realistic situation of a polydisperse (or multimodal) sample it is not possible to
provide simple graphical correlations of volume concentrations and obscuration. However, the
system can calculate concentration using the size distribution result and the obscuration.

For a polydisperse sample the curve of the above figure can be used if the Surface Weighted
Mean (D[3, 2]), is plotted rather than diameter and the distribution is assumed to be
monomodal.

9.1.3 Volume-based results
When interpreting Mastersizer results it is important to remember that the fundamental size
distribution derived by this technique is volume-based. For example, when a result indicates
that 11% of the distribution is in the size category 6.97–7.75 microns, this means that the
volume of all particles with diameters in this range represents 11% of the total volume of all
particles.

It is useful to consider a numerical example to illustrate this point. Suppose, that a sample con-
sists of only two sizes of particle, 50% by number having a diameter of 1 micron and 50% by
number a diameter of 10 microns. Assuming that the particles are spherical, the volume of
each of the larger particles is 1000 times the volume of one of the smaller ones. Thus, as a
volume distribution, the larger particles represent 99.9% of the total volume.
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9.1.4 Equivalent spheres
Mie theory assumes that particles being measured are perfect spheres that can be described
by a single number. However, in practice particles are rarely so simple. This makes defining a
3D shape as a single number much harder, which causes a problem when attempting to define
"particle size".

For example, the size of a cuboid cannot be defined by its length alone, its width and height
must also be taken into consideration. When considering much more complex, irregular shapes
such a grains of sand or pigment particles in paint, defining size becomes even more com-
plicated.

One solution to define complex shapes as single numbers is to compare features of that
particle to an imaginary spherical equivalent.

Some typical methods of doing this are:

l Equivalent surface area - calculate the diameter of a theoretical sphere that has the
same surface area of the original particle.

l Equivalent maximum length - this is where the diameter of a theoretical sphere is the
same as the maximum dimension of the original particle.

l Equivalent minimum length - this is where the diameter of a theoretical sphere is the
same as the minimum dimension of the original particle.

There are many other methods available to do this. This technique is known as “equivalent
spheres”.

The Mastersizer uses the volume of a particle to measure size as a single number by cal-
culating the diameter of a sphere that would have the equivalent volume.

Consider a cylindrical particle of diameter 20 microns and length 60 microns. The volume of
the cylinder is:

Chapter 9 Advice and Concepts



199

60µm

 20µm

33µm

Figure 9.2 Cylinder and sphere of equivalent volume

The sphere of equivalent volume would have a diameter of:

If a sample of these cylinders was measured in a Mastersizer, the distribution would span 20
µm to 60 µm, as some particles would pass through the laser end on, appearing 20 µm, and
others side on, appearing 60 µm, and others orientated in between . There would be a mode in
the distribution at 33 µm.

It is interesting to compare this with other techniques. Sieving would pass the particles
through a 20 µm aperture and classify them as 20 µm. Sedimentation would give a result
related to the total surface area, in this case reporting a diameter of around 40 µm.

9.1.5 Derived distribution parameters
The particle size distribution reported by the software is expressed in a set of size classes
which are optimized to match the detector geometry and optical configuration, giving the best
resolution. All parameters are derived from this fundamental distribution.
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Distribution parameters and derived diameters are calculated from the fundamental dis-
tribution using the summation of the contributions from each size band. In performing this cal-
culation the representative diameter for each band is taken to be the geometric mean of the
size band limits:

This number will be slightly different to the arithmetic mean:

For example, the size band 404.21 – 492.47 microns has a geometric mean of 446.16 microns
and an arithmetic mean of 448.34 microns. In most cases the difference is small but the geo-
metric mean is chosen in these calculations as it is more appropriate for the logarithmic spa-
cing of the fundamental size classes.

The same principle of calculation applies to the distribution statistics standard deviation, skew-
ness and kurtosis, as shown below:

9.1.5.1 Standard deviation

9.1.5.2 Skewness

9.1.5.3 Kurtosis

In the above formulae K and X depend on the distribution being calculated as shown in this
table:
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Table 9.1 How to calculate K and X

Distribution K Xi

Volume 3 Vi

Surface 2 Vi /di

Length 1 Vi /di 2

Number 0 Vi /di 3

The various derived diameters are related by:

For “mono-size” distributions such as latex, the distribution mean is reported as the geometric
mean of the size class and standard deviation, skewness and kurtosis are reported as zero.

The procedure used for other parameters of the distribution is to create a spline fit to the fun-
damental result. Intermediate values are then read from this curve allowing interpolation of per-
centile points which do not coincide with the measurement size band boundaries.

9.2 Optical models
This section contrasts the Fraunhofer approximation used in some instruments with the Mie
theory which underpins Mastersizer operation. Although Mie is the preferred scattering model,
users can also select Fraunhofer if required from the measurement settings. Refer to section
10.5.3.

9.2.1 Fraunhofer approximation
Older instruments and some existing instruments rely on the Fraunhofer approximation only.
This assumes that:
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l The particle is much larger than the wavelength of light employed. ISO 13320 defines this
as being greater than 40x wavelength (25 µm when a He-Ne laser is used).

l All sizes of particle scatter with equal efficiencies.
l The particle is opaque and transmits no light.

These assumptions are incorrect for many materials and for small particles they can give rise
to errors approaching 30%, especially when the relative refractive index (RI) of the material
and medium is close to one, or when the particles are transparent. When the particle size
approaches the wavelength of light the scattering efficiency becomes a complex nonlinear
function with maxima and minima present.

9.2.2 Mie theory
Mastersizer Xplorer uses the full Mie theory which completely solves the equations for inter-
action of light with matter. This allows completely accurate results over a large size range.

Mie Theory provides a rigorous solution for the calculation of particle size distributions from
light scattering data and is based on Maxwell’s electromagnetic field equations. It predicts
scattering intensities for all particles, small or large, transparent or opaque within the following
assumptions:

l The particles being measured are spherical.
l The suspension is dilute, so that the scattered light is measured before it is re-scattered

by other particles.
l The optical properties of the particles and the medium surrounding them is known.
l The particles are homogeneous.
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Figure 9.3 Schematic representation of Mie theory

Mie Theory predicts the primary scattering response observed from the surface of the particle,
with the intensity predicted by the RI difference between the particle and the dispersion
medium. It also predicts how the particle’s absorption affects the secondary scattering signal
caused by light refraction within the particle. This is especially important for particles below 50
microns in diameter and is extremely important when the particle is transparent, as stated in
the international standard for laser diffraction measurements (ISO13320-1 (1999)).

9.2.2.1 Requirements for using Mie

Mie theory assumes the particle is spherical, as opposed to Fraunhofer, which is a projected
area prediction. The penalty for this complete accuracy is that the refractive indices for the
material and medium must be known and the absorption part of the RI must be known or estim-
ated. However, for the majority of users this will present no problems as these values either
will be known or can be measured.

A standard set of materials is available for selection in the SOP (presented in section 10.2.3).
Further materials can be defined by a user within the materials database, but the following
parameters must be specified accurately:

l RI (Real) - this value relates to the speed of light within the material, which in turn allows
the degree of refraction (light bending) to be predicted when light passes from one
medium to another.

l Absorption Index - an imaginary number that describes the amount of absorption that
takes place as the light enters the particle.

l Density - the density in g/cm3. This is used to calculate the Specific Surface Area (SSA).
Users who want to include the SSA as a derived parameter must complete this field.
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The residual shown in the Parameters report indicates how well the calculated data fitted the
measurement data.

9.2.3 Refractive Index of the medium
This value is needed by the software in order to provide accurate calculations and is specified
within Mie theory.

Refer to section 9.3 and the Refractive Index and Dispersants Guide at www.mal-
vernpanalytical.com for more information.
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9.3 Refractive Index
The RI of a powdered or finely divided material is a complex number comprising a real part and
an imaginary part.

The real part is the actual RI of the bulk material (e.g. water is 1.33).

The imaginary part is known as the absorption which is a measure of the amount of light
trapped by the particle. The shape of a particle will have a significant effect on its absorption.
For example:

l Glass in sheet form has little or no absorption but powdered glass will have an absorption
of 0.1 owing to the fact that the rough internal surfaces will trap and reflect light.

l Spherical particles - an absorption value of 0 is recommended for particles such as lat-
tices or glass beads.

l Emulsion droplets - an absorption of 0.001 is recommended.
l Solid particles - an absorption value of 0.01 is recommended for particles with some

transparency such as crystalline milled powder.
l Particles with more color or opacity - the absorption value generally increases, for

example, a slightly colored powder may have an absorption of 0.1 and a highly colored or
metal powder may have an absorption value of 1 and above.

l Primary colored samples - adjust the absorption value for each light source, depending
on the color of the sample. For example, a red pigment will not absorb very much red light
but it will strongly absorb the blue light source.

The Mastersizer uses red and blue light to measure samples. For certain materials, (notably
certain inks and pigments) the sample will have substantially different refractive indices in red
and blue light. This is normally due to the material being highly adsorbing in one of the two
wave lengths. In these cases it will be necessary to enter both refractive indices. For most
materials, you will not need to enter a blue RI. If a blue RI is not given, then the Mastersizer
assumes that it has the same value as the red RI.

Blue refractive indices can be found from papers and textbooks in the same way as red RI
information. When no published information is available, select the RI that minimizes the fit and
residual.
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The fit graph is the comparison between the observed and model predicted extinction values.
This value is particularly sensitive when dealing with wholly sub-micron distribution of
particles.

l If the predicted value exceeds that of the observed value then the absorption value has
been set too high.

l If the observed value exceeds that of the predicted value then the absorption value has
been set too low.

Careful examination of the fit to the higher detectors may well show a slight mis-match.

l If the predicted value from the higher detectors exceeds that of the observed value then
the absorption value has been set too high.

l If the observed value from the higher detectors exceeds that of the predicted value then
the absorption value has been set too low.

Calculation of volumetric concentrations can be used to confirm that the correct RI values
have been used for particles of a generally granular nature without excessive aspect ratios
(less than 4:1).

If after a careful measurement of a known volume concentration suspension of the material,
the Mastersizer reports a value of volume concentration within 10 – 15 % of the known figure,
then confirmation of the RI choice has been made. This procedure involves some inevitable
errors and thus a reasonable tolerance must be permitted.

Refer to the Refractive Index and Dispersants Guide at www.malvernpanalytical.com for more
information.

9.4 About obscuration
This section provides more background on obscuration and how to achieve the optimal results
during method development.

The sample concentration is controlled by monitoring the obscuration of the laser beam
caused by the sample. The obscuration is simply the fraction of light “lost” from the main beam
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when the sample is introduced. For example, an obscuration of 30% means that 30% of the
incident laser beam (recorded during the Measure Background step) has been lost through
scattering or absorption.

If the obscuration is too high, then multiple scattering may occur resulting in a very inaccurate
measurement. If the obscuration is too low then insufficient signal will be detected and the pre-
cision will be adversely affected. Set limits to enable the system to detect poor conditions and
take action either to ignore data, raise alarms or to trigger the measurement process once a
limit has been exceeded. Values may be set manually or default values for the selected sample
handling unit may be enabled.

When adding sample, there can be a delay between adding the sample and the obscuration
level settling to the correct level. For this reason it is also possible to specify a time delay, after
the initial reading within the correct obscuration band, to allow the sample to become evenly
distributed.

Figure 9.4 Obscuration level as displayed in the software

9.4.1 Advice on setting obscuration level
The obscuration bar on the Laser panel provides a color coded indication of the following:

Table 9.2 Obscuration levels

Obscuration range (%) Obscuration bar color Notes

<5 Green Add more sample.
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Obscuration range (%) Obscuration bar color Notes

5-10 Green Low, but usable with a good signal to background
ratio.

10-20 Green Ideal.

20-50 Orange Danger of multiple scattering.

50 Orange Too high.

Each material/dispersant combination has an ideal obscuration band at which accurate meas-
urements can be made. As a rough guide use a range of 10-20% for a wet dispersion unit and
0.1-10% for a dry dispersion unit.

9.5 Pump and stirrer settings

9.5.1 General advice

l The pump/stirrer keeps a homogeneously dispersed suspension of particles in the tank
which can then transport all sizes of particle through the flow cell for measurement.

l Larger particles with densities above that of the suspending fluid must be kept flowing
through the pipes and flow cell at a high enough velocity to prevent the largest particles
from settling out.

l It is also necessary that the largest particles are moving through the flow cell at approx-
imately the same speed as smaller particles in order that the effects of velocity bias do
not influence the final result.

l Both the actions of the pump and the stirrer subject the suspension to the influence of
shear stress.

l In general, the larger and more dense the particle the higher the pump/stirrer speed
needs to be.

l It may be highly desirable to add a surfactant to the liquid in order to stabilize the sus-
pension. However excess surfactant or excessive pump/stirrer speeds while using sur-
factants can readily produce foam that will distort the result.
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9.5.2 Work with emulsions

l Many emulsions can have their drop sizes reduced by exposing them to high levels of
shear. It is not possible to transport liquid suspensions through pipe networks without
adding some shear stress. However in the case of emulsions, it is necessary to establish
that the liquid transport is not materially changing the size distribution.

l A test should be conducted whereby the emulsion is diluted and circulated through the
measurement cell using the minimum amount of pumping and stirring which just re-cir-
culates the suspension. Remember that it will take much longer to reach an equilibrium
state under these conditions.

l Conduct a series of measurements at various pumping speeds with an adequate pause
between changes of pump speed to determine whether the size distribution is being
changed.

9.5.3 Liquid level and vortexing

l It is possible (but not recommended) to conduct a measurement with the fluid level in the
tank lower than normal. Under these conditions, excess pump/stir speeds can induce air
bubbles into the suspension via the vortex from the central pump and stirrer shafts.

9.6 Sample stability issues

9.6.1 Agglomerating
Agglomerates are groups of particles which are loosely coherent.

If particles are agglomerating some of the particles will be passing close enough to each other
for surface interactions to create a single, larger particle. As there are fewer particles, there
are fewer scattering events and more light passes through the measurement zone unimpeded.
This causes the obscuration to decrease. Meanwhile, the volume in the coarse fraction of the
particle size distribution may increase or the coarse fraction may increase in size. Therefore,
the size below which there is 90% of the volume of the sample, Dv90, will increase. Plotting
Dv90 and obscuration in a trend view for an agglomerating sample will look like this:
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Figure 9.5 Agglomerating sample

Remedies for agglomeration include:

l Use surfactant or additives to stabilize the dispersion.
l Use a lower sample concentration i.e. a lower obscuration.
l Conduct an ultrasound titration or change dispersants.

9.6.2 Dispersing
Agglomerates and loosely bounded particles are slowly broken apart and dispersed into
primary particles due to the addition of energy from the action of stirring. In some cases, this
process can be slow. This causes the obscuration to increase. Meanwhile, the volume in the
coarse fraction of the particle size distribution may decrease .

Therefore, the size below which there is 90% of the volume of the sample, Dv90, will decrease.
Plotting Dv90 and obscuration in a trend view for a dispersing sample will look like this:
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Figure 9.6 Dispersing

Remedies for dispersing include:

l Increase the pre-measurement delay to allow for the agglomerates to disperse as an
action of stirring.

l Increase the stirrer speed.
l Conduct an ultrasound titration first.

9.6.3 Dissolving
If particles are dissolving, the fine particles will get smaller and then disappear, making the
coarse fraction more dominant. As there are fewer particles in the system, there are fewer
scattering events and more light passes through the measurement zone unimpeded, causing
the obscuration to decrease. Meanwhile the size below which there is 10% of the volume of
the sample, Dv10, will increase. Plotting Dv10 and obscuration in a trend view for a dissolving
sample will look like this:
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Figure 9.7 Dissolving

Remedies for dissolution include:

l Use another dispersant.
l Select the dispersant with the least dissolution.
l Prepare the sample under controlled conditions using a saturated solution.

9.7 Ultrasound
Particles can stick together due to Van der Waals forces, electrostatic forces, and molecular
bonding. Ultrasonication can disperse a sample by breaking these bonds through shear stress
from sonic waves. It’s mainly used for materials with high sub-micron content.
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Note: Ultrasonic agitation adds heat to the system, which can raise the suspension’s tem-
perature and sometimes promote aggregation. It can also break fragile crystals. Avoid
using ultrasound on emulsions, as it may cause further emulsification, leading to unrep-
resentative results.

Use a good microscope to visually inspect the particle suspension. If an SOP is being pro-
duced for a material which is subject to FDA or MCA scrutiny, retain the results of this work,
together with any photomicrographs and other supporting evidence. This is an important part
of the method validation documentation.

Conduct a series of measurements, doubling the ultrasonication duration each time. The res-
ults should clearly show the effect of ultrasonics on the material. If particle size is still changing
after 15 minutes, reconsider the suspending liquid or any admixture used for wetting.

To evaluate the dispersion state of the sample in the Mastersizer, three key steps are involved
in the dispersion titration process:

1. A set of repeat measurements to assess the effect of stirring the sample - this helps
determine whether ultrasound is necessary or if stirring provides adequate energy for dis-
persion.

2. A series of measurements to assess the effect of ultrasound on the sample - this allows
users to determine whether continuous ultrasound is required.

3. A set of repeat measurements to assess the stability of the measurement after ultra-
sound - this helps identify whether the sample is agglomerating after ultrasound applic-
ation.

An example of a dispersion titration in water is shown below.

l Stage 1 shows gradual dispersion as the sample is stirred.
l Stage 2 shows faster dispersion when the ultrasound is on.
l Stage 3 shows that the results are stable once the ultrasound has been turned off.
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Figure 9.8 Dispersion titration example

The dispersion titration shows a change in the particle size distribution consistent with agglom-
erates being dispersed, as shown in particle size distributions below.

Figure 9.9 Particle size distribution

As the sample disperses there should also be an increase in the obscuration (related to the
concentration of particles in the system) as each agglomerate is broken up into multiple
primary particles, as shown below.
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Figure 9.10 Increase in obscuration

If you are measuring in an organic solvent, apply ultrasound in steps. For example, apply ultra-
sound for one minute, then wait for the dispersant's temperature to stabilize before meas-
uring. This prevents false readings due to temperature gradients. Repeat this process until no
further size reduction is observed.

A dispersion titration helps determine the ultrasound power and duration needed to disperse
the sample to its primary particle size. If the titration shows no size reduction, the sample may
already be fully dispersed. If particle size continues to decrease without stabilizing, the ultra-
sound might be breaking the primary particles.

Particle size should remain stable in stage 3. If it increases due to re-agglomeration, an addit-
ive may be needed to stabilize the dispersion.

Verify the dispersion state using a microscope or static automated particle imaging instrument
(Hydro Insight) by taking an aliquot from the dispersion accessory. Observations before and
after ultrasound will show if agglomerates have dispersed or if the particle shape has changed
due to breakage.

9.7.1 External sonication
External sonication can be applied to assist dispersion.

1. Place the beaker of slurry in an ultrasonic bath or under a sonication probe for a suitable
duration (initially start with two minutes, though this can vary depending on the sample
type).

2. Evaluate the effectiveness of sonication through visual inspection. Make sure that no
large agglomerates are present in the sample.
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3. Allow the pre-dispersant mix to cool down, as sonication can generate significant heat,
particularly when using non-water dispersants.

4. Add the sample to the dispersant tank.

5. Do a series of measurements to determine if the sample has reached a stable dispersion
state.

6. If the results remain unstable, clean the system, prepare a fresh pre-dispersant mix, and
apply sonication for a longer duration.

The figure shows example measurements where sonication has improved the dispersion. After
the first period of ultrasound, the particle size has decreased but there are still agglomerates
present. Further sonication was therefore applied until all of the agglomerates have been dis-
persed and the results have become stable.

Figure 9.11 Particle size distributions with 0, 5 and 10 minute applications of ultrasound

Once you have identified a suitable duration to sonicate your sample externally, repeat the pro-
cess until you have collected three complete sets of measurements to confirm stability (i.e. 3
aliquots).

Additional ultrasonics can be applied to the tank to help prevent re-agglomeration, though this
is not always necessary.

Note: When working with fragile particles, sonication may cause them to break down. If there
is any uncertainty, conducting microscopic observation before and after sonication will
provide insight into how the ultrasonics affect the sample.
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9.8 Stir speed titration
The stirrer in a wet dispersion unit must ensure that the dispersion is homogenous and that the
sample passing through the measurement cell is representative. For larger or denser materials,
you need to carry out a stir speed titration to check that all the particles in the sample have
been suspended. For emulsion samples a stir speed titration can tell you at what speed the
droplets begin to be broken by the action of the stirrer.

A stir speed titration is an important step in method development for coarse (Dv90 > 500 µm),
dense (e.g. metal powders) and polydisperse (e.g. soils) materials.

Figure 9.12 Stir speed titration

9.9 Laser obscuration titration
Obscuration is a measure of how much sample has been added to the dispersion unit. An
obscuration titration is an important step in liquid dispersion measurements as it determines
how much sample should be added. If too much sample is added, there is a risk of multiple
scattering causing the reported particle size to decrease. If too little sample is added, large
particles may not be represented and Dv90 may be unstable due to noise in the scattering
data.

To determine the most appropriate obscuration range for your sample, perform a series of
measurements. Start at ~3% obscuration and add more sample, in 4-5 steps, until ~20%

Chapter 9 Advice and Concepts



218

obscuration. Look at the percentiles in the trend view and select an obscuration range where
the trend is flat. The percentiles may start to decrease at high obscuration’s due to multiple
scattering and this region should be avoided.

Figure 9.13 Laser obscuration titration

An obscuration titration for a fine material, which shows multiple scattering effects at low val-
ues of obscuration, might look like this. Measurements should be made in the stable region
indicated, with 3-5% obscuration.

Figure 9.14 Obscuration titration - fine material
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9.10 Further recommendations for method
development
The following recommendations can optimize your method and improve repeatability.

9.10.1 Measurement duration
The measurement duration in a wet laser diffraction measurement needs to be long enough to
allow a representative sample of the particles in the dispersion unit to circulate through the
measurement cell. The required duration will depend on the particle size and the poly-
dispersity of the sample. A fine mono disperse sample only needs a short measurement,
whereas coarse particles or broader distributions require longer measurements. If you see
high variability over repeat measurements of the same sample (for large particles or broad dis-
tributions) then increasing the measurement duration may improve repeatability.

Figure 9.15 Measurement duration

This shows the particle size distribution of a sample containing material with a broad size
range (from 1 μm to 700 μm). Repeat measurements of this sample have been made using a
range of measurement durations from 1 second up to 20 seconds.

The following figure shows the decrease in relative standard deviation (over the five repeat
measurements) for increasing measurement durations. The variability is within the acceptable
range, according to the ISO standard, for measurement durations above 10 s.
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Figure 9.16 Broad size range distribution

9.10.2 Sample addition
It is important for any particle characterization technique that the sample you put into the
instrument is representative of the bulk of your material. Sampling becomes the largest pos-
sible source of error in the measurement of coarse particles or samples containing a broad
range of sizes.

To get a representative result you need to measure a minimum number of particles. For
example, to get the Dv90 to within a 5% standard error requires at least 400 particles to be
measured. Therefore, for a material with a density of 1.5 g/cm3 and a Dv90 of 500 μm you
would need to measure about 0.5 g to get the Dv90 to within a 5% standard error. As the size
of the particles increases the mass containing sufficient particles increases, and the minimum
mass required to achieve reproducible results also increases.
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Figure 9.17 Sample addition

This shows the minimum mass required to achieve a 5% standard error as a function of particle
size. You can test whether your sample mass, or technique, is sufficient by measuring several
separate sub-samples and assessing the variability of the results.

9.10.3 Fine powder mode
Fine powder mode removes artefacts which can be caused by movement of dry powders or
thermal mixing. These effects cause noise on the Mastersizer low angle detectors, and fine
powder mode removes the data from some of these detectors from the analysis.

Note: Removing these low angle detectors limits the upper size of the instrument to 600 µm.

For dry powder measurements, fine powder mode is always recommended for samples con-
taining a significant amount of particles below 10 µm in size i.e. for Dv90 < 10 µm. For particles
with Dv90 in the range from 10-100 µm fine powder mode may be used if noise on the inner
detectors is creating unexpected modes at large sizes.
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Figure 9.18 Dry powder measurements

For liquid measurements, fine powder mode is sometimes used when a fine sample is meas-
ured in an organic solvent. This removes coarse particle modes, created by thermal instabil-
ities, from the result. It is preferable to allow the dispersant to reach thermal equilibrium before
beginning a measurement, but in some cases, for example when a significant amount of ultra-
sound has been applied, fine powder mode may be necessary.

Note: Particles larger than 600 µm cannot be reported when fine powder mode is active.

Figure 9.19 Fine powder mode

Fine powder mode can allow you to work with samples in difficult circumstances, but should
not be used as a substitute for proper method development. It is always worth comparing a res-
ult with fine powder mode active, with the original result, to assess the effect.

Refer to section 10.5.1 for details about using Fine powder mode.

As it is an analysis setting, the result can be reprocessed with and without fine powder mode
without the need to make further measurements.
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9.10.4 Adaptive diffraction - FEATURE KEY
The Size Sure method of adaptive diffraction produces more reliable and reproducible results
by reducing the influence of factors outside the sample. It does this by separating out these
"transients" from the measurement. Refer to section 10.3.1 for more information.
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10.1 About Measurement settings
Both SOPs and Manual Measurements involve specifying a number of settings before the
measurement can be run.

The Measurement settings window is displayed whenever you create a new SOP or manual
measurement.

Figure 10.1 Measurement settings

This window groups settings into logical sections in which various parameters for the meas-
urement are defined as follows:
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l Sample (section 10.2) - identify the sample and provide more information to users of the
SOP. Define the physical characteristics of the sample and dispersant.

l Measurement (section 10.3) - set both the red and blue light measurement durations, the
number of, and delay duration between, measurements. Specify the obscuration levels
for the measurement.

l Sample Dispersion (section 10.4) - control the behavior of the currently connected
accessory.

l Data Processing (section 10.5) - specify the scattering model, analysis options and
modify the light detectors used in a measurement. Define any Analysis Smoothing, Size
Range/Resolution options and set size banding for all measurement histograms and
tables.

l Output (section 10.6) - controls the manner by which the measurements results can be
exported and reported.

The SOP Editor view can be changed by selecting File and deselecting or selecting Tree view
in the list. This will show the SOP editor as either single titled screens or as a tree view with all
screens identified in a column on the left.

Step through the SOP windows by selecting the required measurement screen in the tree or
use the icon to step through each screen.

Note: When progressing through the settings, any icon next to a field indicates that you
must specify a value for the field before continuing to the next section.

With the measurement setting specified click OK to close the SOP Editor window.

The rest of this section goes through each of the measurement settings in more detail.

10.2 Sample settings
The Sample settings group allows you to define the sample and dispersant type as well as
choosing the appropriate particle type.

The following windows are covered:
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l Identification - section 10.2.1
l Particle Type - section 10.2.2
l Material - section 10.2.3
l Dispersant - section 10.2.4
l Instructions - section 10.2.5

10.2.1 Identification
The Sample identification settings allow you to enter details to identify the sample and provide
more information to users.

Figure 10.2 Sample identification measurement settings window

When the measurement is run, you will be prompted to confirm or alter the fields specified
here.

Enter the following information:

l Sample Name (mandatory) - a descriptive name for the sample, such as "Batch 1A" or
"Series 3, Sample 1".

Further fields can be added as required by your organization's work flow, or fields that could
be useful in providing the operator with more information. This feature could be used to
provide information that needs to be drawn to a user's attention immediately, such as "Exper-
imental measurement set: increased stirrer speed."

l To add additional fields - for example, Batch, Lot, Group etc., click the Add but-
ton. The new field is added to the list. Enter a name for the field in the drop down menu to
the left of the field. For a required field (i.e. one that is mandatory for the operator to
enter), check the Required field box.
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Note: The icon next to a field indicates that the user must specify a value for the field
before saving the SOP or running the manual measurement.

l To re-order the list of fields - drag the item up or down by clicking and dragging the
icon next to the item.

l To remove unwanted identification fields - click the icon adjacent to the field.

10.2.2 Particle Type
The Sample particle type settings allow you to specify the shape of particles under analysis in
order for the software to apply the optimal analysis model.

Figure 10.3 Sample particle type measurement settings window
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The following settings are available:

Table 10.1 Particle types

Particle type Description

Non-spherical This analysis mode is applicable for particles which are irregular in shape,
or have a rough surface structure. For example, it should be selected for
milled or crushed materials. This mode uses Mie Theory, and therefore
requires input of the optical properties of your sample in order to calculate
a particle size distribution. The advantage of this is that it provides the pos-
sibility of obtaining accurate size distributions for all particle sizes.

Spherical This analysis mode is applicable for particles which are perfectly spherical
in shape. For example, it should be selected for polymer latex samples or
for emulsions. This mode uses Mie Theory, and therefore requires input of
the optical properties of your sample in order to calculate a particle size dis-
tribution. The advantage of this is that it provides the possibility of obtain-
ing accurate size distributions for all particle sizes.

Opaque particle
(Fraunhofer
approximation)

The Fraunhofer Approximation can be used to calculate particle size dis-
tributions in cases where the particle size is large and where the particles
can be assumed to be completely opaque. It is the easiest mode to use, as
you do not have to provide any optical properties in order to calculate a
size distribution. However, its use may lead to inaccurate results, par-
ticularly for small particles below 50 microns in size or for those which are
transparent.
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10.2.3 Material
Use the Sample material properties section to enter physical characteristics of the material
being measured.

Figure 10.4 Sample material measurement settings window

It is possible to specify the dispersant details manually or to choose from the Materials Data-
base.

1. To select a previously added material from the Materials Database, click Browse data-
base, then select an item from the database and click Use these values.

2. Alternatively add the new Material details in the respective fields. If the newly added
material will be used in the future, add it to the Materials Database by clicking Add to
database.

Table 10.2 Dispersant properties

Material property Action

Material name Enter a descriptive name for the material

Refractive index (RI) Enter a value between 0 and 5. This value relates to the speed of light
within the material, which in turn allows a degree of refraction to be pre-
dicted when light passes from one medium to another.
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Material property Action

Absorption index (AI) Value between 0 and 10, which is a measure of the quantity of light
absorbed by the particles. Generally, transparent samples will have a low or
zero absorption while colored or black particles will have a higher value.

Density Value of between 0.001 and 25 g/cm³.

Different blue-light prop-
erties

If required, select the check box and add the Refractive index (blue-light)
and Absorption index (blue-light) .

Note: This is a unique setting for Wet dispersion units.

References and notes Any further comments that help describe the material.

10.2.4 Dispersant

Note: This is a unique window for wet dispersion units.

Use the Sample dispersant section settings to specify the properties of the dispersant used in
the measurement.

Figure 10.5 Sample dispersant measurement settings window

It is possible to specify the dispersant details manually or to choose from the dispersant data-
base. Refer to section 5.5.

1. To select a previously added material from the Dispersants Database, click Browse data-
base, then select an item from the database and click Use these values.

2. Alternatively add the new dispersant details in the respective fields. If the newly added
dispersant will be used in the future, add it to the Dispersants Database by clicking Add
to database.
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Table 10.3 Dispersant properties

Dispersant property Action

Dispersant name Enter a descriptive name for the dispersants, for example, Ethanol.

RI Enter a value of between 0 and 5. This value relates to the speed of light
within the material, which in turn allows the degree of refraction (light
bending) to be predicted when light passes from one medium to another

Level sensor threshold Only for Hydro MV/LV units that are fitted with an analogue sensor -
MAP3210/3310).
The Sample–Dispersion SOP window contains a level sensor threshold
field where a value can be inputted that is suitable for the level sensor to
detect the dispersant level when filled. The value will be different
depending upon the dispersant used.

The level sensor in the dispersion unit automatically stops the tank being
overfilled above a certain level. If the tank fails to fill properly then the
level sensor threshold, for the dispersant being used, may need adjust-
ing. This value can be changed either manually (for the current meas-
urement only) or by using the section 5.5, to store the new values for
future use.

Configuring this threshold value will be done using the Accessory con-
trols panel - refer to: section 5.3.1.

References and notes Enter any further comments that help to describe the dispersant.

10.2.5 Instructions
Use the Sample instructions settings to specify pre-measurement and post-measurement
instructions that need to be drawn to the attention of the user.

Figure 10.6 Sample instructions measurement settings window
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The following settings are available:

l Show instructions before measurement begins - instructions that are shown in the
Sample Documentation panel/window before the measurement.

l Show instructions when measurement is complete - instructions that are shown in the
Sample Documentation panel/window following the measurement (after the meas-
urement view is closed).

10.3 Measurement settings
The Measurement settings group allow you to define the following:

l Adaptive Diffraction (Size Sure) - section 10.3.1
l Duration - section 10.3.2
l Sequence - section 10.3.3
l Obscuration - section
l Alarm - section 10.3.5

10.3.1 Adaptive Diffraction (Size Sure) - FEATURE KEY
The Adaptive Diffraction settings are used to specify the adaptive diffraction mode to use
when processing a measurement's results.

Figure 10.7 Measurement adaptive diffraction settings
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Size sure mode produces more reliable and reproducible results by reducing the influence of
factors outside the sample.

During a laser diffraction measurement, most of the time the detectors observe a steady laser
scattering signal from the sample. However, laser scattering events caused by other factors
can change the signal on the detectors for a brief period of time. These events are known as
transients, and could be caused by factors such as:

l small quantities of contaminants such as grit, or dust in the sample.
l misalignment of the laser due to vibrations.
l presence of bubbles in the dispersant/sample.

If transients are present in a measurement, the particle size distribution may no longer be an
accurate representation of the sample, or the fit quality may be affected.

Adaptive Diffraction separates the steady and transient scattering signals by classifying the
measurement data into a "steady state", and a "transient state". This can mitigate for the
effect of transients.

Select Size Sure mode to apply Adaptive Diffraction analysis to your measurements:

Figure 10.8 Size Sure mode

Note: Size Sure mode cannot subsequently be applied to a measurement completed using
No Adaptive Diffraction.

The following graphs show an example result with No Adaptive Diffraction and when Size Sure
mode is used:
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Figure 10.9 No Adaptive Diffraction

Figure 10.10 Size Sure

The plot with No Adaptive Diffraction shows an apparently bimodal distribution. The plot with
Size Sure mode applied shows classification into the steady state (solid curve) and the tran-
sient state (dotted curve). A small quantity of material at approximately 1000 µm has been clas-
sified as transient, enhancing confidence in the steady state particle size distribution.
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10.3.1.1 Extract classic result

If the adaptive diffraction mode is set to Size Sure, you have the option of also extracting the
classic result from the measurement. The classic result represents the result as if Adaptive Dif-
fraction were not applied.

Figure 10.11 Extract Classic Result option

The classic result will automatically be generated for each adaptive diffraction result. This lets
you compare the results with and without adaptive diffraction.

Note: You can also extract the classic result after you have run the measurement. In the
record view, right-click on the adaptive diffraction record and select Extract Classic
Result...
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Figure 10.12 Extract Classic Result menu option

10.3.2 Duration
The Measurement duration settings can be used to separately specify both the red and blue
light measurement durations.
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Figure 10.13 Measurement duration measurement settings window

10.3.2.1 Red measurement duration(s)

You must specify both the Background and Sample measurement duration in seconds.

Background measurement duration (seconds)

A measurement is made using only clean dispersant, which is then subtracted from the sample
measurement by the system in order to ‘clean’ the data. This is usually set to at least the same
duration as the sample measurement.

Sample measurement duration (seconds)

The optimum measurement time depends on the size of the sample, the span of the particle
size distribution and the dispersion accessory used. If a material is monomodal its essential
particle size characteristics can be captured in less time than a material with a broad particle
size distribution, which will need to be measured for longer to make sure that the coarser
particles have been properly represented.

10.3.2.2 Blue measurement duration(s)

Note: This is a unique setting for wet dispersion units.

The blue light measurement is more significant when measuring small particles under 1 µm in
size. There is a gradual reduction in the significance to the overall measurement result as the
particle size increases above 1 µm.
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Some red and yellow samples (such as pigments) can absorb light in the blue spectrum. This
may lead to problems with the validity of the data acquired during the blue light part of the
measurement. If you have such a sample, the blue light measurement can be disabled, so lim-
iting the measurement to the main red laser.

l Select Use the durations I specify, and specify both the Background and Sample meas-
urement duration in seconds.

l If no blue light measurement is required, select Don't perform blue light measurement.
This will speed up the measurement time.

10.3.2.3 Data stability

To make an accurate measurement of the size of a distribution of particles, it is essential to
accurately record the light scattered by the sample. This requires the intensity of light incident
upon the detectors to be measured before the sample is present in the cell.

In a light scattering measurement the intensity of light incident upon the detectors is meas-
ured before the sample is present in the cell. This is then subtracted after the measurement is
made and during the analysis. If the background is not stable before the measurement begins
then the subtraction could remove real data and introduce an error in the size distribution.

For example, if you put a cold solvent into the dispersion unit, which is usually a little bit
above room temperature, this causes variations in temperature of the dispersant (as it
warms up). These temperature gradients will cause some extra scattering which means
that the background signal can be very high.

Figure 10.14 Example of high background signal
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The signal will then decrease as the dispersant circulates and when the measured high
background signal is subtracted the resulting data can be negative.

Figure 10.15 Example of negative result

The Data stability feature monitors the stability of the background while it is being measured
and only records the background scattering when it is stable as defined by criteria within the
software.

Under certain laboratory conditions though the time it takes for the background to become
stable may be unacceptably long. In this case, you can define the time to wait before indic-
ating that Data stability has not been reached.

If Assess light background stability is selected:

l Should the background remain unstable in the allowed time it will display a warning mes-
sage in the notification panel and the log.

Figure 10.16 Warning message in the notification panel
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l If the background is found to be stable the measurement automatically proceeds with
the Measure Sample step, without further report.

10.3.3 Sequence
The Measurement sequence settings window allows you to specify the number of aliquots and
measurements per aliquot in a complete measurement.

Figure 10.17 Measurement sequence measurement settings window

10.3.3.1 Measurements

If the material is difficult to disperse, requiring ultrasonication, surfactant or both to achieve a
stable dispersion, several measurements of the same sample may be required in order to
determine the ideal dispersion time. In general, repeat measurements are performed until the
last measurement obtained agrees closely with the previous one.

Complete the following Measurement options:

l Enter the number of measurements (up to 999) and delay between measurements (up to
9999 seconds). Specifying several measurements, e.g. 5, allows repeatability to be
assessed.

l In wet measurements a pre-measurement delay (s) can be specified. This delay occurs
before the very first measurement but after Ultrasound has been stopped, assuming the
pre-measurement ultrasound option is selected.

l Pre-alignment delay - this inserts a pause before the alignment stage of the meas-
urement to allow for dispersant equilibration. This can be useful, for example, when meas-
uring in organic dispersants.
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10.3.3.2 Options

Option to close the Measurement display window at the end of the measurement.

10.3.4 Obscuration
The Measurement obscuration settings enable you to specify the obscuration levels between
which the measurement will be conducted. This is critical for ensuring the correct amount of
sample is added to the measurement system.

Figure 10.18 Measurement obscuration measurement settings window

The optimal obscuration settings for a measurement are both sample and dispersion unit
dependent. As a rough guide, use a range of 10-20% for a wet dispersion unit and 0.5-6% for a
dry dispersion unit.

For more information on obscuration settings, refer to section 9.4.
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10.3.4.1 Measurement obscuration limits

Set the following parameters:

Figure 10.19 Obscuration limits

l Obscuration lower limit (%) - enter a percentage value from 0.1 to 20 above which the
measurement should be run.

l Obscuration higher limit (%) - enter a percentage value from 0.1 to 20 below which the
measurement should be run.

This information is found on the Laser panel of the measurement sequence:

10.3.4.2 Enable measurement to auto-start

If required, select Auto start measurement when obscuration is in range.

l It is also necessary to set a Stabilization time delay in seconds - this will then add a delay
before the measurement initiates after the obscuration level is first detected within the
specified band. This is most commonly used when obtaining dry measurements.

10.3.4.3 Measurement obscuration filtering

Select the Enable filtering option to optionally set the software to only record data where the
obscuration was within the specified range. This is most useful for dry measurements.
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l The Time out option forces the measurement to stop if no such data are recorded within
the specified number of seconds.

10.3.5 Alarm

Figure 10.20 Measurement alarm measurement settings window

The following settings are available in the Measurement alarm section:

10.3.5.1 Background cleanliness alarms

The cleanliness of the optics can be checked by considering the level of the background sig-
nal measured while clean dispersant is circulating through the system. To help with this assess-
ment, the SOP can be set up so an alarm threshold is set for the background scattering level
measured for each detector. If the background exceeds the threshold when the SOP is run
then a cleanliness alarm is reported.

To activate and set the alarm thresholds:

1. Select the Check background cleanliness check box - the background levels entry fields
will now become active.

To set the alarm thresholds:
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A. Select a Detector from the drop-down.

B. Input the Max energy level required before the alarm is activated (i.e. alarm
threshold) and select the button.

C. Repeat for all required detectors.

D. To delete a detector setting select it from the drop-down and select .

2. Once the background levels alarms have been created, they can be used in the meas-
urement by selecting the Check background cleanliness check box before exiting.

10.4 Sample dispersion
The Sample dispersion group allows you to set the accessory parameters and cleaning
sequence settings

The following windows are covered:

l Accessory - section 10.4.1
l Cleaning - section 10.4.2

10.4.1 Accessory control settings
The Accessory control settings allow you to set up the behavior of the connected accessory
during an SOP measurement. This section provides details on the following accessory con-
trols:

l Hydro LV/MV
l Hydro SV
l Aero S

Note: As they are manual accessories, there are no control settings available for the Hydro
SM or Aero M.

10.4.1.1 Accessory control settings - Hydro LV/MV and Hydro EV

This section describes the Hydro LV/MV and Hydro EV accessory control settings.
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Figure 10.21 Example of Sample dispersion settings

Stirrer speed

These dispersion units have a variable-rate stirrer allowing flexible control of sample flow and
agitation. The stirrer speed may be controlled manually using the Wet Accessory window or
may be controlled by a predefined SOP for automatic operation.

To control the stirrer from an SOP:

1. Using manual control, initially determine the optimum stirrer speeds. This is to make sure
that the lowest setting that gives satisfactory dispersion is obtained.

2. Make a note of the settings and enter these into the SOP Accessory control settings.

3. Click and drag the slider bar to set the speed.
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It is also possible to control the accessory manually by using the Accessory Controls panel
(from the Measurement display window) or the from the Tools > Accessories option at any
other time.

Tank fill behavior

l This is an option for Hydro MV/LV dispersion units only

The tank can be filled with dispersant manually or automatically.

Automatic: the dispersant is plumbed into the accessory and an internal regulator valve con-
trols the flow of dispersant into the tank. If an organic dispersant is used, it more usual to manu-
ally fill the tank.

Manual: the solenoid valve is switched off so the dispersant inlet does not have to be dis-
connected during filling, and the tank can be filled by hand. The software tells the operator
when to fill the tank during an SOP measurement. Carefully pour the dispersant directly into
the tank, or use the upper dispersant inlet port. In this case the supply to this inlet is enabled
either through the use of an external pump and cable, or another regulation method.

Dispersant Source:

This option enables the dispersant inlet to be switched between the lower internally regulated
inlet port (commonly used for aqueous samples) and the upper externally regulated inlet port
(commonly used for non-aqueous samples).

This is useful for instances after a measurement has been performed using an expensive
organic dispersant - supplied via the upper externally regulated non-aqueous inlet. It may be
undesirable to then use this expensive dispersant for cleaning, so the tank and cell can then
be cleaned with a cheaper comparable alternative.

The Dispersant source options are:

l Auto - both inlets activated and can be used. This is the default selection, and is the set-
ting used for SOPs that were set up in previous software versions where this option did
not exist. This will activate both the lower regulated and upper externally regulated inlets
when required.

Note: If this option is used, only one supply should be connected to the accessory to prevent
the two dispersant supplies mixing inadvertently.
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l Internal - will control and activate the lower internally regulated dispersant inlet port.
There is an internal regulated valve rated to handle mains pressure.

l External - will control and activate the upper externally regulated dispersant inlet port.
The upper dispersant inlet is externally regulated. There is no internal regulator fitted to
control the dispersant. It is therefore recommended that the supply to this inlet is
enabled through the use of an external pump and cable.

Note: Both valves will be closed when in standby or when power is supplied to the access-
ory.

Fill the tank manually

Fill the tank slowly until the tank light flashes - this indicates the correct fluid level for sample
addition and running measurements. If the tank is filled higher than this, sample and particles
may be lost through the over-flow system. This will lead to an incorrect particle size dis-
tribution being reported.

Degas

If dispersant is stored under pressure or at low temperature, consider degassing before use.
The pressure release or temperature rise reduces the solubility of gases. This will result in pos-
sible bubble formation in the pipes and tank.

Select Degas after fill to remove bubbles and dissolved gases from the dispersant before use.
Once the tank is filled, this runs the stirrer briefly to dislodge any bubbles from the cell walls,
and then stops the stirrer to allow the bubbles to be released.

Note: It is preferable that all dispersants are degassed before being added to the system.
Degas by storing the dispersant at room temperature and pressure before use.

Ultrasonics

This sample dispersion unit has an ultrasonic transducer which can assist the dispersion of
cohesive samples. Use the Wet Accessory window to set the level and duration of ultrasound
manually. Alternatively predefine these settings in an SOP.

To determine the correct ultrasonic level for an SOP:
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1. Use manual control to determine the best/minimum ultrasound settings required to give
satisfactory dispersion.

2. Make a note of the settings and enter them into the SOP in the Sampler Settings page.

3. Click and drag the slider bar to set the power level.

4. Set the Ultrasound Mode to one of the following:
l None - no ultrasound is applied.
l Pre-Measurement - ultrasound is activated for a set time prior to measurement. For

pre-measurement mode, enter the required duration in seconds in the Duration
box.

l Continuous (from Sample Addition) - ultrasound is activated after sample is added
and will run continuously.

l Continuous (from Measurement Start) - ultrasound is active throughout the meas-
urement. Ultrasound will start after the electrical background is complete. The sta-
bilizing period will add a delay between the electrical background and the optical
alignment. During this delay ultrasound will be active to allow bubbles to be driven
from the dispersant.

To manually control the ultrasonic level from the Wet Accessory window:

1. Select and drag the Ultrasound slider bar to set the level, or select the bar and use the
keyboard control up/down/left/right arrows - this will step the ultrasonic level up or down
in 10% divisions. Alternatively, for an exact setting, double click on the displayed ultra-
sonic value and type in the required level.

2. Degas after ultrasound - select this check box to remove any bubbles that may have
occurred during ultrasound.

3. Align after ultrasound - select this check box to align the cell once the ultrasound has
completed.

Pulsed Ultrasonics

Enable pulsed ultrasonication - in this mode, ultrasonication is applied in pulses (with fixed dur-
ation on and off pulses). This option can be used in combination with both continuous or timed
ultrasonication mode. To specify the duration of on and off pulses, enter the required values
(seconds).

10.4.1.2 Accessory control settings - Hydro SV

This section provides information on the Accessory control settings for the Hydro SV.
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Figure 10.22 Active accessory controls for the Hydro LV and Aero S

Stirrer speed

Refer to section 10.4.1.1 for details.

Note: The software stirrer slider bar, and the SV front panel manual control dial are syn-
chronized. Movement of the slider bar will alter the front panel display, and vice versa.

10.4.1.3 Accessory control settings - Aero

This section describes the Aero S and Aero M accessory control settings.

Figure 10.23 Active accessory controls for the Aero S

Air pressure

Use this slider bar to set the air pressure at which the sample is circulated (from 0 to 4 bar, in
0.1 bar increments). Lower air pressures can be better for fine or fragile particles, higher air
pressures for agglomerates or metallic particle samples.
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Feed rate

This controls the vibration speed of the feed tray. Use the slider bar to set the rate at which
the sample is fed into the system. The correct feed rate is one at which the sample is vibrated
evenly along the feed tray and gives the required obscuration. This rate is best established as
part of a method development process.

Configuration

l This is an option for Aero S dispersion units only

Use the pull-down menus to select both the venturi and tray types to be used in the meas-
urement.

l Venturi type - the type of venturi currently installed in the dispersion unit.
l Tray type - the tray type currently in use.
l Hopper gap (mm) - Input the hopper gap that has been manually set for the sample meas-

urement.

10.4.2 Cleaning
Cleaning after a measurement is essential to make sure that background noise, that consists
of particles that have agglomerated within the system and formed accumulations, is min-
imized.

Note: The Hydro MV/LV dispersion units also have Pre-Clean settings that are exactly the
same as the Cleaning settings. These let you specify cleaning that is done before a
measurement.
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Figure 10.24 Active accessory controls for the Hydro LV and Aero S

The following settings are available to make sure no contamination occurs:

10.4.2.1 Clean sequence

Each clean type specifies a set number of cycles (nothing further is changed in the cleaning
method). Select a clean type of either Quick, Normal, Extensive or Custom. If Custom is selec-
ted you must also manually specify the number of clean cycles.

If the same sample type is measured in succession, a Quick clean may be sufficient. After the
last measurement in a session, perform an Extensive clean to make sure that the system is as
free as possible from contamination in readiness for the next measurement session.

10.4.2.2 Hydro dispersion units

Note: There are no cleaning control settings for the Hydro SM and Hydro SV.

Tank fill behavior

l This is an option for Hydro MV/LV dispersion units only

Refer to section 10.4.1.1 above for a description of the Tank fill behavior, including filling the
tank manually and the Dispersant source and Degassing options.

Level sensor threshold

The level sensor threshold value is only required for Hydro units that are fitted with an analog
sensor (MAZ3210/3310). Refer to section 10.4 and section 5.3.1.
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Ultrasonication

Ultrasound can reduce agglomeration, which may help further with cleaning. Select whether to
Use ultrasound during the clean sequence or No ultrasound during clean.

10.4.2.3 Dry dispersion units

Note: There are no cleaning control settings for the Aero M.

Air pressure

Use the slider bar to set the air pressure at which any remaining sample is removed (from 0 to
4 bar, in 0.1 bar increments).

Feed rate

This controls the vibration speed of the feed tray. Use the slider bar to set the rate at which
the sample is removed.

10.5 Data processing
The Data processing group allows you to set the following settings:

l Analysis - section 10.5.1
l Result - section 10.5.2
l User sizes - section 10.5.3

10.5.1 Analysis
The Data processing analysis settings allow you to specify the analysis model and modify the
light detectors used in a measurement.
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Figure 10.25 Data processing analysis measurement settings window

Tip: If unsure which analysis settings are best suited to your application, try reapplying dif-
ferent analysis settings following an initial measurement to observe the results. To do
this, use the edit result feature on your initial records.

Table 10.4 Analysis model options

Model
icon

Model name Function

General Pur-
pose

This model is appropriate for most samples, including naturally occurring
and milled materials. You should select this model unless you know that
your sample meets the more specific requirements stated for the other
analysis modes provided for the Mastersizer system.

Narrow Pur-
pose

This model is appropriate for samples consisting of one or more narrow
modes, where each mode spans much less than a decade in size. It is not
intended for use with broad distributions which exhibit more than one
peak.

Verification
Latex

(This is a unique setting for wet dispersion units)

This model is designed to enable the analysis of one or more very narrow
Latex size standards, such as those used during verification of the instru-
ment.

Note: For all of the analysis model, use the Keep a single result mode option in the Advanced
settings to force the analysis to only report the most significant mode present within
the sample.
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10.5.1.1 Fine Powder Mode

This option should be enabled for samples containing a significant proportion of material
below 10 microns in size with an upper limit of 600 µm. It can help improve the result repro-
ducibility, and can be used with any of the Mastersizer analysis modes.

10.5.1.2 Analysis Model (Mastersizer 2000/2000E emulator mode)

With the Enable Mastersizer 2000/2000E Analysis Emulator options enabled, the following
additional emulated Mastersizer 2000/2000E analysis models are added to the list. The emu-
lator converts a Mastersizer 3000/3000E/3000+ result to how it would be analyzed on a
Mastersizer 2000/2000E instruments. The extra analysis modes are:

General Purpose (Emulated MS2000/MS2000E)

This model is appropriate for the majority of milled and naturally occurring samples.

Multiple modes (Emulated MS2000/MS2000E)

This model is appropriate for sample consisting of one or more very narrow modes.

Single mode (Emulated MS2000/MS2000E)

This model is appropriate for sample consisting of one very narrow mode.

10.5.1.3 Advanced

Click Advanced to reveal these additional options:
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Figure 10.26 Advanced analysis options

Analysis Modes

Use Keep a single result mode if you know your sample has a single mode size distribution.
This option eliminates any small modes produced by noise on the measurement.

Disable Detectors

Set the number of inner (low scatter-angle) detectors to be ignored by the analysis.

Thermal fluctuations in the dispersant can cause signals in the inner channels to be inter-
preted as large particles. Set the number of detectors to remove the effect of these fluc-
tuations, at the expense of reducing the sensitivity to the presence of real large particles.

Red-Light Only

Remove Blue Light from Analysis allows a measurement made with red and blue light to be ana-
lyzed as if the blue light was not used.
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Sensitivity

Enhanced sensitivity has maximum sensitivity to any small modes that are separated from the
main particle mode. Normal sensitivity (default) subtracts more of the background and
reduces small extra modes.

The Fine Powder Mode option should be enabled for samples containing a significant pro-
portion of material below 10 microns in size. It can help improve the result reproducibility, and
can be used with any of the Mastersizer analysis modes.

Virtual lens range

This feature is only available if it is selected for use from the Options window - refer to section
2.10.1.

Figure 10.27 Virtual Lens Range settings

Virtual lens ranges limit the result analysis range to that of a legacy instrument, such as a 300
mm lens used on a Mastersizer X, and are used to help with method transfer from older Mal-
vern Panalytical laser diffraction systems.

Select each lens range to truncate both the detector range and the size range of the Master-
sizer system to match the selected system.

Alternative Mastersizer Analyses

Select this option to force a measurement to be analyzed as if it was made on a different
Mastersizer variant.

l Measurements on a Mastersizer 3000+ Ultra can be analyzed as if they were made on a
3000+ Pro or 3000+ Lab.

l Measurements on a Mastersizer 3000+ Pro can be analyzed as if they were made on a
3000+ Lab.

l Measurements on a Mastersizer 3000 can be analyzed as if they were made on a 3000E.
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Note: All options are available when you create an SOP. When the SOP is run, the software
checks which instrument is running and will not run the SOP if it is being forced to do
an invalid analysis. For example, a Mastersizer 3000+ Lab cannot run an SOP that has
been set to analyze measurements as if they were made on a Mastersizer 3000+ Pro.

Selecting one of these options will override some of the other advanced settings. For example,
the number of virtual lens ranges available may be reduced.

10.5.2 Result
The Data processing result settings allow you to specify the displayed size range and the type
of distribution that the analysis has used in the measurement.

Figure 10.28 Data processing result measurement settings window

Alter the parameters as required.
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10.5.2.1 Result range

Reducing the measurement range is not usually a recommend option, especially when con-
forming to good laboratory practice. This facility is useful though if a sample includes two or
more distinct size populations which may need to be monitored individually.

Adjusting the low size and high size range will alter the fit applied to the fundamental result.
The intermediate values are then read from the curve allowing interpolation of percentile
points. This adjustment will not alter the analysis bands that are used in the measurement.

Note: The software will automatically flag the use of any range reduction facility to preserve
the integrity and traceability of the results.

10.5.2.2 Result type

Set the result type for the particle size distribution - choices are Volume distribution (recom-
mended), Surface area distribution or Number distribution. By default the Mastersizer meas-
urement is a measurement of the volume distribution - transforming the result into number
distribution is a mathematical process that may amplify any error in the original result. Small
volumes of small particles may be transformed into significant numbers of particles.

10.5.3 User Sizes
The Data processing user sizes settings allow size banding for the measurement to be defined
for all histograms and tables used in reports.
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Figure 10.29 Data processing user sizes measurement settings window

10.5.3.1 User Sizes

Size bands can be used when using sieves that conform to specific standard sizes.

The system can either automatically set size bands for histograms and charts, or these can be
user-specified.

Use default sizes

Select this check box to automatically select appropriate high and low sizes based on the
measurement result.

Use the sizes that I specify

Select this check box to manually define size bandings. The User sizes (µm) and Generate
user sizes panels become active.

Create user size bands as follows:

1. From the Generate user sizes panel, enter the required Lower size and Upper size limits
(in µm).

2. Then enter the Number of bands into which the table or histogram should be divided.
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3. Select a Distribution type:
l Linear: Divides the bands into equal sizes. This is useful for narrow particle size dis-

tribution (e.g. 1 to 10 µm).
l Logarithmic: Divides the bands into logarithmic sizes. This is useful for wide particle

size distributions spanning several orders of magnitude (e.g. 1 to 1000 µm).

4. Click Generate sizes to populate the set of figures in the User sizes panel.
l To add more size bands, enter a figure into the Size (µm) field and then click the

button. The new figure is then added to the list in the correct numerical position.
l To delete one of the size bands, select the figure you wish to remove and then click

.
l To save size band information that you wish to re-use within other SOPs, click

to save the current sizes. To use previously saved sizes, click and then locate
the relevant .siz file.

5. Click the icon to progress to the next screen or click OK to close the window.

Note: Refer to description below for reporting standard sieve sizes.

Retrieve User sizes.

Any size file can be retrieved using the User Sizes button on the Tools ribbon (Folders group).

Figure 10.30 Retrieving user sizes

10.5.3.2 Report standard sieve sizes

Result tables can be set up to display results using standard sieve MESH sizes. This is con-
figured using the User Sizes option.
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To display the MESH sizes, users must first load in the required sieve size data - select the Use
the sizes that I specify option described above and then load in the file containing the data for
the sieve set required.

Sieve sizes are available for all standard ASTM, BS, ISO and Tyler sieve sets.

l The ISO sieve size sets includes a list of the micron sizes for all of the available sieves.
These sieves are in the same format as the standard Mastersizer size class files.

l The ASTM, BS and Tyler sieve size class files include a MESH reference for each size
class. In this case the list includes the standard microns size, along with the MESH size in
brackets.

To report the MESH sizes in the report configure the result table in a report to use the MESH
sizes stored in the User Sizes file, rather than micron sizes. To do this create a new result table
in a report, and then change the properties of the table to report the Size in Sieve Mesh
Values.
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10.6 Output
Use this section of the measurement settings to set up an export specification. The following
windows are covered:

l Data Export - section 10.6.1
l Averaging - section 10.6.2
l Printing - section 10.6.3

10.6.1 Data Export
The Output data export window allows specific data to be selected for analysis in other soft-
ware applications, for example Microsoft Excel.

Figure 10.31 Output data export measurement settings window
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To enable exporting select the Export data? check box. then select either the Default template
or create a Custom one. The Default template reflects the current workspace settings and
uses the record view column configuration.

10.6.1.1 Export Type: Standard

This option provides preselected Malvern Panalytical standard export template settings.

Export settings

Alter the export settings as required. This will alter the way in which the exported documents
are formatted when exported to the receiving application.

Table 10.5 Export settings

Choose either rows or columns from the Ordering selector to present the data
horizontally accordingly.

From the Delimiter selection, choose either Comma separated (csv) or Tab sep-
arated. Your choice will depend on the requirements of the target application.

Use the Formatting option to select either Format values as displayed in
software, which displays numeric information to a limited number of decimal
places (this may be preferable for presentation purposes) or Unformatted values
to show all data as recorded by the system.

Select Header on/off to specify whether the export should contain the names of
the fields as a header row (or column).

Select Overwrite to either replace or append the previously exported data.

Parameters

Note: The search feature is only available with the Extended software license.
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Click the Change selection and order button to show the Parameter selection window, then
select the required parameters.

Filename

Name the exported data file as required. Click Change filename and select the parameters, if
any, that are to be added to the filename. The file will be saved as a .txt or .csv file as determ-
ined by the delimiter selection.

Destination

The exported file will be saved in the Export Data folder of the current workspace.

10.6.1.2 Export Type: SPC

The SPC export template contains two additional header field and the ability to add a prefix to
the exported content. This is useful for statistical analysis of large quantities of date produced
by the Mastersizer system. The additional parameters for the SPC template are described
below. For all other parameters refer to the standard template description.

Export settings

Formatting and Overwrite only are available. Refer to the Standard template for a description.

Parameters

Parameters selection is as Standard template.

Prefix: This allows a prefix to be added to the exported data.

Header One/Two Parameters

A Header parameter can be used indicate either run-specific data, like the Sample name or
traceability-specific data such as the Instrument Serial number. The Parameters selection is as
Standard template.

Again a Prefix can be added to the exported data.

Filename

As Standard template.

Destination

As Standard template.
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10.6.2 Averaging
An SOP can be set to run through a number of measurements, with an average result then
being created at the end. This is set on the Output averaging window.

Figure 10.32 Output averaging measurement settings window

10.6.2.1 Create an average

After the measurements have finished it may be advantageous to see the average value pro-
duced from all the measurements run. Selecting the Create average measurement on SOP
completion check box will enable this option.

10.6.3 Print options
The Output printing window allows specific reports to be selected for printing.
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Figure 10.33 Output printing measurement settings window

10.6.3.1 Print report

To enable printing select the Print report? check box.

10.6.3.2 Select printer

Select the Always use default printer check box if a certain printer is to be used, otherwise
select from the drop-down list.

10.6.3.3 Records to print

Select the radio button as required to select the records needed.

Options are:

l Measurement records
l Measurements records with average
l Average measurement record
l All records.
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10.6.3.4 Available reports and Reports to print

This window contains a list of Available reports on the left and Reports to print on the right.

Select the reports you want to print in the Available list and use the arrow buttons to move
them to the Reports to print list.
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